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Preface

This guide describes how to install and configure Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) v2.4. 0 Service Pack 4 and OUASA Base Installation v2.4.0. 

Audience
This guide is intended for anyone interested in understanding or performing the process of 
installing or configuring Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Service 
Pack 4.

Related Documents
For more information, refer to the following documents in the Oracle Utilities Advanced Spatial 
and Operational Analytics Documentation Library:

• Oracle Utilities Advanced Spatial and Operational Analytics Release Notes

• Oracle Utilities Advanced Spatial and Operational Analytics Quick Install Guide

• Oracle Utilities Advanced Spatial and Operational Analytics Administration Guide

• Oracle Utilities Advanced Spatial and Operational Analytics User's Guide

• Oracle Utilities Advanced Spatial and Operational Analytics Licensing and Package Guide

• Oracle Utilities Customer Care and Billing Business Intelligence Metric Reference Guide

• Oracle Utilities Meter Data Management Business Intelligence Metric Reference Guide

• Oracle Utilities Network Management Business Intelligence Metric Reference Guide

• Oracle Utilities Work and Asset Management Business Intelligence Metric Reference Guide

• Oracle Utilities Mobile Workforce Management Business Intelligence Metric Reference Guide

• Oracle Utilities Customer Care and Billing Business Intelligence Data Mapping Guide

• Oracle Utilities Meter Data Management Business Intelligence Data Mapping Guide

• Oracle Utilities Network Management Business Intelligence Data Mapping Guide

• Oracle Utilities Work and Asset Management Business Intelligence Data Mapping Guide

• Oracle Utilities Mobile Workforce Management Business Intelligence Data Mapping Guide

• Oracle Utilities Application Framework Business Process Guide 

• Oracle Utilities Application Framework Administration Guide 

• Oracle Utilities Business Intelligence Server Administration Guide
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Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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Chapter 1 
OUASA v2.4.0 Service Pack 4 Install 

Instructions

This chapter covers general installation instructions for Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA)version 2.4.0 Service Pack 4 based on possible customer 
installation scenarios.

For complete details, refer to Installing OUASA v2.4.0 Service Pack 4.

Following installation related topics are discussed: 

• Changes in Supported Platforms

• Changes in Supported Oracle Utilities Products for OUASA v2.4.0 Service Pack 4

• Installation Types

• Package Contents

• Previous Service Pack Release Enhancements

Changes in Supported Platforms 
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0.Service Pack 4 (OUASA 
v2.4.0.4) is also certified on two additional platforms as described below:

• Oracle Enterprise Linux (OEL) 6.2 64 bit with OBIEE 11.1.1.6.4 and 11.2.0.3 Oracle 
database Software

• Windows Server 2008 R2 64 bit with OBIEE 11.1.1.6.4 and 11.2.0.3 Oracle database 
Software.

Note: To install OUASA v2.4.0 Service Pack 4 from scratch on the above 
platforms or any other platforms that are certified, you must first install the 
OUASA base installation v2.4.0 on your system. 

Note: If you are installing OUASA v2.4.0 on OEL 6.2 with OBIEE 11.1.1.6.4 
and 11.2.0.3 Oracle database Software or on Windows Server 2008 R2 64 bit 
with OBIEE 11.1.1.6.4/11.2.0.3 Oracle database Software, you must refer to 
and follow procedures outlined in the chapter “Installing OUASA v2.4.0 
Base Installation’’ and  skip the post-installation tasks for OUASA ETL 
Component installation. Then, proceed with procedures outlined in the section 
“Upgrading OUASA v2.4.0 to OUASA v2.4.0 Service Pack 4’’ in chapter 
Installing OUASA v2.4.0 Service Pack 4.
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Installation Types
Changes in Supported Oracle Utilities Products for OUASA v2.4.0 
Service Pack 4

This section describes the changes for the existing supported Source Applications. If customers 
want to use OUASA v2.4.0 Service Pack 4 with Oracle Utilities Meter Data Management (MDM) 
or Oracle Utilities Mobile Workforce Management (MWM as Source Applications, then they must 
have these versions of MDM and MWM described below:

• Oracle Utilities Mobile Workforce Management (MWM) version 2.1.0.4 Release (patch 
number 14774547) plus Single Fix patch number 14791886.  
This is applicable only for customers using MWM Extractor & Schema and MWM Analytics.

• Oracle Utilities Meter Data Management(MDM) (patch number 14676555) version 2.0.1.8 
plus Single fix patch number 14741869 plus Single fix patch number 15983267.  
This is applicable only for customers using MDM Extractor & Schema and MDM Analytics.

Installation Types
Note: Oracle Utilities Advanced Spatial and Operational Analytics version 
2.4.0 or 2.4.0.x is a prerequisite for installing Oracle Utilities Advanced Spatial 
and Operational Analytics version 2.4.0 Service Pack 4.

The following are the possible installation types based on customer scenarios:

• Initial Installation or Installing OUASA v2.4.0 Service Pack 4 from scratch

• Upgrading OUASA v2.4.0 or 2.4.0.x to OUASA v2.4.0 Service Pack 4

• Demo Installation

Initial Installation or Installing OUASA v2.4.0 Service Pack 4 from scratch
For customers installing OUASA v2.4.0 Service Pack 4 for the first time, they need to follow the 
install procedures in the sequence described below:  

• First, install OUASA Base Product v2.4.0

• Then, upgrade from OUASA v2.4.0 to OUASA v2.4.0 Service Pack 4

Upgrading OUASA v2.4.0 or 2.4.0.x to OUASA v2.4.0 Service Pack 4
This installation type is applicable when you are upgrading to Oracle Utilities Advanced Spatial 
and Operational Analytics version 2.4.0 Service Pack 4 from an earlier release version of OUASA.

• Supported Upgrade Paths

Supported Upgrade Paths
Direct upgrade to Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 
Service Pack 4 is supported for the following versions:

• Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 or 2.4.0.x

Note: To upgrade to OUASA v2.4.0 Service Pack4, customer must already 
have OUASA v2.4.0 or 2.4.0.x installed. For customers, who want to upgrade to 
OUASA v2.4.0 Service Pack 4 from earlier release versions of OUASA v2.4.0, 
they must first upgrade to OUASA v2.4.0 and then to OUASA v.2.4.0.4.

Demo Installation
A Demo Data Install is an installation that is pre-populated with demo data.
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Previous Service Pack Release Enhancements
Package Contents
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 Service Pack 4 Media 
Pack consists of the following installation and documentation packages:

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0.4 Multiplatform.zip

• OUASA-v2.4.0.4-Database-Multiplatform.zip

• OUASA-v2.4.0.4-PFDs.zip - Product Fix Documents for OUASA single fixes included in this 
service pack

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0.4 User Documentation.zip

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0.4 Release Notes.zip

For details, refer to chapter Installing OUASA v2.4.0 Service Pack 4.

Previous Service Pack Release Enhancements
This section describes the enhancements and bug fixes included in earlier Service Pack releases of 
OUASA v2.4.0 and includes the following: 

• OUASA v2.4.0 Service Pack 3

• OUASA v2.4.0 Service Pack 2

OUASA v2.4.0 Service Pack 3
OUASA v2.4.0 Service Pack 3 includes the following enhancements as described below: 

• Enhancements

Enhancements
This section describes the enhanced features in the Oracle Utilities Advanced Spatial and 
Operational Analytics version 2.4.0 Service Pack 3, including:

Oracle Utilities Exception Analytics
New dashboards included in Exception Analytics for Oracle Utilities Customer Care and Billing 
To-Do entries. The new dashboards are as follows:

• Overview

• Incomplete To-Do Entries

• To-Do Entries

Note: Refer to the Oracle Utilities Exception Analytics Metric Reference Guide for a 
detailed description of the new dashboards and analyses.

OUASA v2.4.0 Service Pack 2
OUASA v2.4.0 Service Pack 2 includes the following enhancements as described below: 

• Enhancements

Enhancements
This section describes the follwing new features included in Oracle Utilities Advanced Spatial and 
Operational Analytic version 2.4.0 Service Pack 2:

• Customer Care and Billing Analytics

• Work and Assets Analytics
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Previous Service Pack Release Enhancements
• Outage Analytics and Distribution Analytics

• Meter Data Analytics

• Improved ETL Fact Load Exception Management

Customer Care and Billing Analytics
This section describes the enhancements to Oracle Utilities Customer Analytics, Oracle Utilities 
Credit & Collections Analytics, and Oracle Utilities Revenue Analytics. It includes the following:

• New dashboard enhancements, including new Overview pages, additional drill down to 
other pages, and Detail pages.

• Drill back into the Oracle Utilities Customer Care and Billing application from within the 
BI dashboard.

Work and Assets Analytics
The enhancements to Oracle Utilities Work & Asset Management Analytics include:

• Reorganized dashboards with improved visual metaphors.

• Additional drill-down points providing more analytical workflow support.

Outage Analytics and Distribution Analytics
The enhancements to Oracle Utilities Outage Analytics and Oracle Utilities Distribution Analytics 
include:

• Reorganized dashboards and additional drill-down points providing more analytical 
workflow support.

Meter Data Analytics
The enhancements to Oracle Utilities Meter Data Analytics include the following:

• Additional drill-down points for improved analytical workflow support.

• New answer enabling comparative analysis of events, activities, and exceptions between 
various entities, such as head end systems, service providers, and device manufacturers.

Improved ETL Fact Load Exception Management
The enhancements to ETL fact load exception management include the following:

• Capturing invalid dimension reference while loading fact, identifying specific records in 
error, and facilitating easy error correction.

• Allowing customers to associate custom exception handling procedure to fact loads to 
manage other types of exceptions besides invalid dimension reference.

Note: See the Oracle Utilities Advanced Spatial and Operational Analytics Administration Guide for a 
detailed description for Improved ETL Fact Load Exception Management enhancement.
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Chapter 2 
OUASA Base Installation Introduction 

Oracle Utilities Advanced Spatial and Operational Analytics (OUASA) version 2.4.0 Base 
Installation consists of the following components:

• Star schema definitions

• ETL process built on Oracle Warehouse Builder (OWB)

• Pre-built analytics' dashboards based on Oracle Business Intelligence Enterprise Edition 
(OBIEE)

• OUBI - Oracle Utilities Business Intelligence (OUBI) includes Oracle Utilities Application 
Framework (OUAF)-based application to generate process flows using OWB Code 
Generator. This is an optional component and is required only if you need to customize or 
create new custom OWB process flows. 

Note that the term OUASA would typically refer to the first three components mentioned above. 
Only these three components are required for a typical installation. This document provides 
information about these components which are commonly required by most of the customers.

Functionality Changes in OUASA v2.4.0
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 comes with a set of new 
functionalities. These can be divided into four groups, such as architectural changes, data 
warehouse schema, Extract-Transform-Load (ETL), and installation modifications.

Architectural Changes
The architectural changes are as follows:

• A new administration group has been added to the dashboards allowing users to administer 
and configure OBIEE. The features supported in the administration section include:

• New write back reports introduced to manage the labels in reports within OBIEE itself.

• New dashboards allowing users to view and manage load jobs. Jobs can be resubmitted 
using this dashboard.  
Refer to the "Running and Monitoring Extract Loads" section in the Oracle Utilities 
Advanced Spatial and Operational Analytics Administration Guide for details.

• The Oracle Utilities Application Framework (OUAF) component is no longer mandatory. 
Only those users who wish to make use of the code generator need to purchase licenses for 
the OUAF component.  
Refer to the "Overview of Environment Maintenance" section in the Oracle Utilities Advanced 
Spatial and Operational Analytics Administration Guide for details.
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Functionality Changes in OUASA v2.4.0
• A new mechanism has been put in place to automatically refresh the OBIEE cache data, as 
soon as new data arrives into the warehouse.  
Refer to the "Auto Cache Refresh" section in the Oracle Utilities Advanced Spatial and Operational 
Analytics Administration Guide for details.

Schema Changes
The schema changes are as follows:

• A new group of dashboards grouped under Oracle Utilities Meter Data Analytics has been 
added. This group provides reporting metrics on the Oracle Utilities Meter Data 
Management (MDM) application. This change includes a set of eight dashboards and the 
underlying star schema to support these analytics. 
Refer to the "Oracle Utilities Meter Data Management Extractor Details" section in the Oracle 
Utilities Advanced Spatial and Operational Analytics Administration Guide for details on the extract 
methodology.

• A new group of dashboards grouped under Oracle Utilities Mobile Workforce Analytics has 
been added. This group provides reporting metrics on the Oracle Utilities Mobile Workforce 
Management (MWM) application. This change includes a set of six dashboards and the 
underlying star schema to support these analytics.  
Refer to the "Oracle Utilities Mobile Workforce Management Extractor Details" section in 
the Oracle Utilities Advanced Spatial and Operational Analytics Administration Guide for details on 
the extract methodology.

• The new dashboards now support drill back to the source edge applications (Oracle Utilities 
Meter Data Management or Oracle Utilities Mobile Workforce Management) directly from 
the reports. 
Refer to the "OUASA: Configuring Drill Back" section in the Oracle Utilities Advanced Spatial 
and Operational Analytics Administration Guide for details.

Extract-Transform-Load Changes
Following are the modifications done to the Extract-Transform-Load component:

• All load jobs is now scheduled automatically by the file processor. Users just need to extract 
files and then copy them into the load directory; the system takes care of the remaining tasks. 
Refer to the "About the File Processor Daemon" section in the Oracle Utilities Advanced Spatial 
and Operational Analytics Administration Guide details.

• New validation step has been introduced in the load jobs, to validate the number of records 
actually loaded against the number records in the flat file being loaded. Refer to the "Oracle 
Warehouse Builder Transformations" in the Oracle Utilities Advanced Spatial and Operational 
Analytics Administration Guide for details.

• All workflows will be enabled for parallel processing; however, the degree of parallelism is set 
to 1. Customers will need to change the degree based on their data volumes processing 
capabilities.  
Refer to the "Parallelism and Partitioning" section in the Oracle Utilities Advanced Spatial and 
Operational Analytics Administration Guide for details.

• Additional workflows have been provided for purging the Oracle Workflow runtime audit 
tables. These have to be scheduled by the customer.  
Refer to the "Purging Audit Records" section in the Oracle Utilities Advanced Spatial and 
Operational Analytics Administration Guide for details.

Installation Changes
The modifications during the installation process are listed as follows: 
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Functionality Changes in OUASA v2.4.0
• Oracle MetaBase (OMB) Plus scripts will be delivered to automate the import of the released 
Oralce Warehouse Builder (OWB) Metadata Loader (MDL) files and the configuration and 
deployment of the OWB objects.

• Install scripts will retain customizations for parallel settings during upgrades.
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Chapter 3 
OUASA Base Installation Overview

Oracle Utilities Advanced Spatial and Operational Analytics (OUASA) Base Installation version 
2.4.0 consist of several components each of which needs to be installed for a successful 
installation. See Installation Components for the list of components comprising the Oracle 
Utilities Advanced Spatial and Operational Analytics product.

Certain prerequisite software may need to be installed for installing each of these components. See 
Prerequisite Software for the list of prerequisite software necessary for installing each 
component.

Oracle Utilities Business Intelligence products supports the following and requires installation of 
OUASA v2.4.0.

• Oracle Utilities Customer Care and Billing release 2.2.0 or 2.3.1

• Oracle Utilities Meter Data Management release 2.0.1, Service Pack 6

• Oracle Utilities Mobile Workforce Management release 2.1.0

• Oracle Utilities Network Management System release 1.9.0.3, 1.10.0.3.1, or 1.11.0.1

• Oracle Utilities Work and Asset Management release 1.8.1 or 1.9.0.4

Note: The single fix patches 13532002, 13518963, 13509909, 13470718, 
13462900, 13460426, 13455478, 13111451, and 13513139 (for Oracle Utilities 
Mobile Workforce Management) are prerequisites for Oracle Mobile Workforce 
Analytics.

The single fix patches 13494493 and 13554621 are prerequisites for Oracle 
Utilities Meter Data Management.

The single fix patches 12861412 and 12797646 (for Oracle Utilities Customer 
Care and Billing 2.2.0) or single fix patches 12861408, 12797637, 13464490, 
12853107, and 12860480 (for Oracle Utilities Customer Care and Billing 2.3.1) 
are prerequisites for Oracle Utilities Customer Care and Billing Business 
Intelligence.

The single fix patch 13503077 (for Oracle Utilities Network Management System 1.11.1) is a 
prerequisite for Oracle Utilities Network Management Business Intelligence.
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The following figure shows the workflow for the initial installation process:
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The following figure shows the workflow for the upgrade process.
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Installation Types
Installation Components
The Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 product installation 
consists of the following installable components.

Each of the components listed below has to be installed to complete the Oracle Utilities Advanced 
Spatial and Operational Analytics installation.

• OUASA Database component containing star schemas and product metadata

• OUASA ETL workflows based on Oracle Warehouse Builder (OWB) 
Note that the OUASA ETL component should be installed on database server.

• OUASA Dashboards components and answers based on Oracle Business Intelligence 
Enterprise Edition (OBIEE) 
Note that the OUASA Dashboard components should be installed where OBIEE 11.1.1.5 is 
installed on the server 

Oracle Utilities Advanced Spatial and Operational Analytics also includes a demo database with 
pre-populated data that can be used for training or demonstration purposes.

Installation Types
The first step in the installation procedure is to determine the installation type based on the 
customer installation scenario. The following are the possible installation types:

• Initial install, an installation from scratch

• Upgrade, an upgrade from an earlier version to OUASA v2.4.0

• Demo data install, an installation with pre-populated demo data

The following sections describe each type of installation, in detail

Initial Installation
This installation type is applicable when installing Oracle Utilities Advanced Spatial and 
Operational Analytics for the first time or from scratch. Each of the following components should 
be installed during an initial installation.

• OUASA Database component 

• OUASA ETL component based on OWB

• OUASA Dashboard component based on OBIEE

See Installing OUASA v2.4.0 Base Installation for the steps involved in installing each of the 
above components.

Upgrade
This installation type is applicable when upgrading to Oracle Utilities Advanced Spatial and 
Operational Analytics v2.4.0 from an earlier version.  
Refer to the section Supported Upgrade Paths to find out whether upgrade of your particular 
version is supported.

Each of the following components should be installed during an upgrade installation.

• OUASA Database component 

• OUASA ETL component based on OWB

• OUASA Dashboard component based on OBIEE
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Additional Software Requirements
Refer to Upgrading to OUASA v2.4.0 Base Installation for the steps involved in upgrading 
each of the above components.

Demo Installation
This installation type is applicable when installing the demo database component of Oracle 
Utilities Advanced Spatial and Operational Analytics for demonstration or training purposes. The 
following components should be installed for a demo installation:

• OUASA Demo database components

• OUASA Dashboard components based on OBIEE

Refer to Demo Installation Procedure for the steps involved in installing each of the above 
components.

Media Pack Contents
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 Media Pack consists of 
the following documentation and installation packages.

Documentation Packages
• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Release Notes

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Quick Install Guide

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Installation and 
Configuration Documentation

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 User Documentation

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Supplemental 
Documentation

Installation Packages
• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Multiplatform

• Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Oracle Database

Note: The Oracle Utilities Advanced Spatial and Operational Analytics version 
2.4.0 Multiplatform package contains the installer for both the ETL 
component and Dashboard component.

Additional Software Requirements
The following additional software products are required to run Oracle Utilities Advanced Spatial 
and Operational Analytics, but are not included in the Media Pack:

• Oracle Business Intelligence Enterprise Edition 11.1.1.5.0

• Oracle Database Server Enterprise Edition 11.2.0.2 with Oracle Warehouse Builder

• Oracle Client 11.2.0.2 Software 32 bit Windows

• Java 1.6 or higher

• Oracle Warehouse Builder Client 32bit Windows
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Architecture
Supported Source Application Versions
The following are the supported source application versions: 

Source Application Version

Oracle Utilities Customer Care & Billing 2.2.0
2.3.1

Oracle Utilities Network Management 
System

1.9.0.3
1.10.0.3.1
1.11.0.1

Oracle Utilities Work & Asset Management 1.8.1
1.9.0.4

Oracle Utilities Meter Data Management Oracle Utilities Meter Data Management 
version 2.0.1, service pack 8 (2.0.1.8) + 
single fix patch # 14741869 + single fix 
patch # 15983267 + framework patch 
14741833

Oracle Utilities Mobile Workforce 
Management

Oracle Utilities Mobile Workforce 
Management version 2.1.0, service pack 4 
(2.1.0.4) +single fix patch 14791886 + 
framework patch 14741833

Architecture
The following figure shows the architecture of the Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) product:
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Chapter 4 
System Requirements and Supported Platforms

Operating Systems and Application Servers
The OUASA Base installation v2.4.0 has been certified to operate on many operating system, 
application server, and database server combinations. For the software requirements for each of 
these combinations, refer to the Oracle Utilities Advanced Spatial and Operational Analytics Installation 
Guide.

The following table details the browser, operating system, and application server combinations on 
which Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 has been tested 
and certified:

OBIEE Browser Operating System 
(Client)

Operating System
(Server) Chipset Application 

Server Database

11.1.1.5

IE 7.x 

IE 8.x

Firefox 3.x 
(OBIEE 

only)

Windows XP SP3

Windows 7

AIX 6.1 (64-bit) Power  
64-bit

WebLogic 
10.3.5

Oracle 11.2.0.2

Oracle Linux 5.6 (64-bit)
Red Hat Enterprise 
Linux 5.6 (64-bit)

x86_64  WebLogic 
10.3.5

Oracle 11.2.0.2

Sun Solaris 10 (64-bit) SPARC WebLogic 
10.3.5

Oracle 11.2.0.2

Windows 2008 Server 
SP2 (32-bit)

x86_64 WebLogic 
10.3.5

Oracle 11.2.0.2

Additional Notes on Supported Platforms
Following topics are discussed in this section: 

• Oracle's Unbreakable Enterprise Kernel

• Oracle Database Server

• Oracle VM Support

• Oracle Support Policy on VMWare

Oracle's Unbreakable Enterprise Kernel
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 is supported on Oracle's 
Unbreakable Enterprise Kernel.
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Additional Notes on Supported Platforms
Oracle Database Server 
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 is supported on Oracle 
Database Enterprise Edition Server 11.2.0.2 on any of the operating systems listed above.

Oracle VM Support
Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 is supported on Oracle 
VM 2.2.1 for supported releases of Oracle Linux and Microsoft Windows operating systems.

Oracle Support Policy on VMWare
Refer to My Oracle Support knowledge base article 249212.1 for Oracle's support policy on 
VMWare.
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Chapter 5 
Planning the OUASA Base Installation

This chapter provides information for planning an Oracle Utilities Advanced Spatial and 
Operational Analytics base installation version 2.4.0, including:

• Before You Install

• Prerequisite Software

• Installation Checklist

Before You Install
Refer to article 1391459.1 on My Oracle Support (https://support.oracle.com/) for latest updated 
information on Oracle Utilities Advanced Spatial and Operational Analytics installation.

Prerequisite Software
For installing Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 few 
prerequisite software needs to be downloaded and installed. Download and install these software 
as per the instructions in the respective installation documents.

The following sections list the prerequisite software for each of the product components of 
Oracle Utilities Advanced Spatial and Operational Analytics:

• Prerequisite Software for OUASA Database Component

• Prerequisite Software for OUASA ETL Component

• Prerequisite Software for OUASA Dashboard Component

Prerequisite Software for OUASA Database Component
The prerequisite software for OUASA database component is as follows:

• Oracle Database Server Enterprise Edition 11.2.0.2: This is required for installing the 
database component of the Oracle Utilities Advanced Spatial and Operational Analytics 
product.

Prerequisite Software for OUASA ETL Component
The prerequisite softwares for OUASA ETL component are as follows:

• Oracle Database Server Enterprise Edition 11.2.0.2 with Oracle Warehouse Builder 11.2.0.2.

• Oracle Warehouse Builder 11.2.0.2 client is required by the installation scripts.

• Java 6 is required for running the File Processor Daemon. 
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Installation Checklist
Prerequisite Software for OUASA Dashboard Component
The prerequisite softwares for OUASA dashboard component are as follows:

• Oracle Business Intelligence Enterprise Edition 11.1.1.5.0 with Enterprise Install Option

• Oracle 11.2.0.2 Client is required by the installation scripts for installing the OBIEE 
dashboard component.

Installation Checklist
The following checklist will guide you through the installation process of Oracle Utilities 
Advanced Spatial and Operational Analytics version 2.4.0.

The details for each step are presented in subsequent chapters.

1. Install prerequisite software. See Prerequisite Software for more details.

2. Determine the installation type. See Initial Installation Procedure to determine the 
installation type for your scenario. Perform the installation steps as applicable to your 
installation type.

3. Install the following Oracle Utilities Advanced Spatial and Operational Analytics 
components:

• OUASA Database component

• OUASA ETL component

• OUASA OBIEE dashboard component

Refer to Installing OUASA v2.4.0 Base Installation for instructions about fresh or 
initial installation.

For upgrading from an earlier version to v2.4.0, refer to Upgrading to OUASA v2.4.0 
Base Installation.

4. Perform post-installation tasks and configure the application. 

5. Refer to After the Installation section for details regarding your selected installation type.
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Chapter 6 
Installing OUASA v2.4.0 Base Installation

This chapter provides instructions for installing Oracle Utilities Advanced Spatial and Operational 
Analytics base installation version 2.4.0.

The chapter includes the following topics: 

• Before You Install

• Initial Installation Procedure

Before You Install
Refer to article 1391459.1 on My Oracle Support for up-to-date additional information on Oracle 
Utilities Advanced Spatial and Operational Analytics installation.

Initial Installation Procedure
The following topics are discussed in this section: 

• OUASA Database Component Installation

• OUASA ETL Component Installation

• OUASA Dashboard Component Installation

• After the Installation

OUASA Database Component Installation
This section describes how to install the database component of Oracle Utilities Advanced Spatial 
and Operational Analytics. The section includes the following topics:

• Copying and Decompressing Install Media

• Database Creation

• DWADM Schema Installation

• Spatial Configuration

Copying and Decompressing Install Media
To copy and decompress the install media, perform these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 
Oracle Database part from Oracle Software Delivery Cloud (https://edelivery.oracle.com/).
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Initial Installation Procedure
2. Create a temporary directory, such as c:\ouasa\temp or /ouasa/temp. (Referred to below as 
<TEMPDIR>) This directory must be located outside any current working Oracle Utilities 
application environment. All files that are placed in this directory as a part of the installation 
can be deleted after completing a successful installation.

3. Copy the file OUASA-V2.4.0-Database-Multiplatform.zip from the delivered package to the 
<TEMPDIR>.

4. Unzip the zip file using any zip utility.

Database Creation
Ensure that Oracle Database Server Enterprise Edition 11.2.0.2 is already installed on machine in 
order to create database and OWB patch 12874883 is also applied to Oracle Home.

Note that you can follow either of the two procedures mentioned below for creating a database. 
After creating a database, proceed to procedure mentioned in section DWADM Schema 
Installation.

You can create a database in any of the following two ways:

• Database creation using the DBCA utility

• Database creation using database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for 
Windows) packaged with product.

Note: After following either of the two procedures for creating a database, 
proceed to and follow the procedures mentioned in section DWADM Schema 
Installation.

Database Creation Using DBCA
For an initial installation database creation, it is recommended that you use the Database 
Configuration Assistant (DBCA) to create a data warehouse database with below-mentioned 
specifications:

1. Create a database with the AL32UTF8 character set. Set the open cursor limit to 3000 and 
processes to 1000.

2. In the database, set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED.

3. Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

4. After the database is created, create the DWADM, DWUSER, and DWREAD users in the 
database, along with the CISTS_01 tablespace that is assigned as the default tablespace to 
DWADM, DWUSER, and DWREAD users. 
The DW_USER and DW_READ roles must be created in the database and the DWUSER 
user should be assigned both roles. The DWREAD user should be assigned only the 
DW_READ role.

Note: Refer to ../BI240/DatabaseCreation/Unix/11g/users.sql to create the 
users and roles mentioned above.

Database Creation Using CDXDBA
Note: The UNIX and Windows database creation utilities creates an empty 
database with AL32UTF8 character set and at least one tablespace for storing 
the application objects before running the installation. The default name of the 
application tablespace is CISTS_01. 

UNIX Database Creation Utility
The files are located in ../BI240/DatabaseCreation/Unix.
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Initial Installation Procedure
1. FTP the contents of the Database Creation folder to a temporary directory on the UNIX 
server.

2. To create the database, set the ORACLE_HOME and the ORACLE_BASE variables.

3. Execute the utility cdxdba.plx by executing the following command:

perl cdxdba.plx

4. Provide the following parameter values when the script prompts:

Instance name (DEMO): DEMO

ORACLE_BASE: the directory where the setup files for the database will be created (/
orasw/app/oracle):

ORACLE_HOME: the folder where the current version of Oracle software is installed 
(/orasw/app/oracle/product/):

ORACLE_DATA: the directory where the data files for the database will be created (/
db05/oradata):

Character set for the database (AL32UTF8):

5. Enter the values based on the settings of your database server.  
You can also accept the default values displayed if they match your database server settings. 
You are prompted to confirm the settings and select Y or N to create the database.

ORACLE_SID: DEMO

ORACLE_HOME: /orasw/app/oracle/product/

ORACLE_BASE: /orasw/app/oracle

ORACLE_DATA: /db05/oradata

Character Set: AL32UTF8

Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

Do you want to import a demo database dump into this database (Y/N)?

Select N to exit the database utility.

7. Set the query_rewrite_enabled parameter to FORCE and the query_rewrite_integrity 
parameter to TRUSTED in the database.

8. Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

9. Update the oratab  file for the new database and then check the connectivity to this database 
from another server and from your desktop after updating local tnsnames.ora file.

Windows Database Creation Utility
The files are located in ..\BI240\DatabaseCreation\Windows. 

You should be logged in as a user who is a member of local ORA_DBA group on that server. The 
ORA_DBA group should have "administrator" privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from 
command prompt. The utility displays the following options:

E - Export a schema from the database

R - Refresh a schema with a database dump
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C - Create/Recreate a local database

H - See help for the command line options

Q - Quit

2. Select option C to create an empty database on your machine and provide below inputs.

3. Provide the instance name (DEMO) : <DB Name> e.g BIDEMO

4. Enter the character set of the database (AL32UTF8) : AL32UTF8

5. Enter ORACLE_BASE: the directory where the setup files for the database will be created 
(c:\oracle) :    <Oracle_Base>  e.g. c:\app\oracle

6. Enter ORACLE_HOME: the folder where the current version of Oracle software is installed 
(c:\oracle\product\11.1.0.6\Db_1) :<Oracle_Home> e.g  c:\app\oracle\db_home

7. Enter ORACLE_DATA: the directory where the data files for the database will be created 
(c:\app\oracle\oradata) :<Directory where data files will be created>

8. Select option Q to exit the utility after database creation.

9. Set the query_rewrite_enabled parameter to FORCE and the query_rewrite_integrity 
parameter to TRUSTED in database.

10. Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

11. Check the connectivity to this database from another server and from your desktop after 
updating local tnsnames.ora file.

DWADM Schema Installation
This section describes the initial installation of DWADM schema. The process prompts you for 
the names of three database users:

• A user that will own the application schema. For example, DWADM.

• A user that has read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application accesses the database as this user. For example, 
DWUSER.

• A user with read-only privileges to the objects in the application schema. For example, 
DWREAD.

The process also prompts you for the following:

• A database role that has read-write (select/update/insert/delete) privileges to the objects in 
the application schema. The application will access the database as this user. For example, 
DW_USER.

• A database role with read-only privileges to the objects in the application schema. For 
example, DW_READ.

• Location for jar files. (The Jar files are bundled with the database package.)

• Java Home. For example, C:\Java\jdk1.6.0_18

Review Storage.par
The storage.par file (that comes with the product) allocates all base tables and indexes to the 
default tablespace CISTS_01. If you decide to allocate some tables or indexes outside of the 
default tablespace, then this has to be reflected in the storage.par file by changing the tablespace 
name from the default value to a custom value, according to the format shown below:

Object Type:Object Name:Tablespace name:Parallel:Comments
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Initial Installation Procedure
Where Parallel defines the number of threads that the Oracle DB Server uses to access a table or 
create an index. Default value is 1.

Installing DWADM Schema
Perform the following steps to install the DWADM schema:

Note: Ensure to run CDXDBI.exe from a Window 32-bit desktop that has the 
Oracle 11.2.0.2 client and Java Development Kit Version 6.0 Update 20 or later.

1. Run CDXDBI.exe from ..\BI240\DWADM\Install-Upgrade. Please run the utility from 
command prompt. The utility prompts you to enter values for the following parameters:

• Name of the target database:<DB NAME>

• Password for the SYSTEM user account in the database (in silent mode)

• Name of the owner of the Database Schema:<DWADM>

• Location of Java Home: <..\jdk1.6.0_20>

• Location of TUGBU Jar files: <..\BI240\DWADM\Jarfiles>

• Password for the user (in silent mode)

• Oracle user with read-write privileges to the Database Schema:<DWUSER>

• Oracle user with read-only privileges to the Database Schema:<DWREAD>

• Oracle database role with read-write privileges to the Database Schema:<DW_USER>

• Oracle database role with read-only privileges to the Database Schema:<DW_READ>

2. If you choose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace, if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions.  
If an error occurs while executing an SQL or another utility, it logs and displays the error 
message and allows you to re-execute the current step.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
using the database, generate the statistics for these new objects.

Spatial Configuration
Refer to section Spatial Configuration for details regarding configuring spatial data.

OUASA ETL Component Installation
This section describes how to install the ETL component of Oracle Utilities Advanced Spatial and 
Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Creating and Configuring Oracle Warehouse Builder Workspace

• OUASA ETL Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
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Initial Installation Procedure
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the Database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID (default cases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation. 

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you use FTP to transfer this file, remember to use the BINARY option for 
the FTP transfer.

4. Decompress the file as follows:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You should have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Advanced Spatial and Operation Analytics application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are re-installing an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, you must ensure to take a backup prior to the 
installation process. The installation utility does not create a backup of existing environment.

Creating and Configuring Oracle Warehouse Builder Workspace
This section describes how create and configure Oracle Warehouse Builder Workspace. It also 
includes details about the following:

• Pre-deployment Steps for Initial Installation
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• Creating and Configuring Workspace for an Initial Installation

Pre-deployment Steps for Initial Installation
Before creating/configuring workspace follow these steps:

1. Execute $ORACLE_HOME/owb/wf/install/wfinstall.csh to configure the workflow in 
database with OWFMGR as user and OWFMGR as password.

2. Install the OWB client 11.2.0.2 on a Windows 32-bit machine.  
Refer to the Oracle Warehouse Builder Installation and Configuration Guide to install and 
configure OWB.  
The configuration guide is available at: http://www.oracle.com/technology/documentation/
warehouse.htm.

3. Apply 12874883 OWB patch to the database server and the OWB client if already not 
applied.

Creating and Configuring Workspace for an Initial Installation
To configure the OWB workspace, follow these steps:

1. Run the $ORACLE_HOME/owb/bin/unix/reposinst.sh command for UNIX from the 
database server.

or

Invoke the repository assistant from Warehouse Builder > Administrator for Windows from 
the database server or client.

2. Provide the following information:

1. Database connection details and click Next.

2. Select Manage Warehouse Builder Workspaces and click Next.

3. Select Create a new Warehouse Builder Workspace and click Next.

4. Select Workspace with a new user as the workspace owner.

5. Provide the system user password.

6. Execute cat_owb.sql as sysdba from <OWBHOME>/owb/UnifiedRepos directory, when 
prompted.

7. Unlock the OWBSYS and OWBSYS _AUDIT accounts using the following commands, if 
this has not already been done.

Connect to sys user and execute the following commands:

ALTER USER OWBSYS IDENTIFIED BY OWBSYS ACCOUNT UNLOCK;

ALTER USER OWBSYS _AUDIT IDENTIFIED BY OWBSYS _AUDIT 
ACCOUNT UNLOCK;

8. Check only Data Integrator Enterprise Edition on Enable Optional Features, and then 
specify the following details:

Workspace Owner's user Name: BIREPOWN

Workspace Owner's password: BIREPOWN

Workspace Name: SPLBIREP

Provide OWBSYS Password:

9. Execute <OWBHOME>/owb/UnifiedRepos /remote_owb_install.sql after logging in to 
sys user, if promoted. When prompted for Oracle Home for Remote OWB software, provide 
the location of OWB Oracle Home.

10. Provide the tablespace info for the OWB workspace schema.
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11. Select the Language. (American Language)

12. Select the Target Schema (DWADM) and Workflow Schema (OWFMGR) from the available 
Repository Users List and move them to Selected. This will register the DWADM and 
OWFMGR schemas with the workspace.

13. On the same screen, click Create New User to create a new workspace user. Specify the 
following details:

User Name: BIREPO

Password: BIREPO

14. Review the information and then click Finish to complete the workspace configuration.

15. Modify the contents of <owb-home>/owb/bin/admin/Runtime.properties file from the 
following to the contents mentioned later.

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint = DISABLED 

property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = DISABLED

property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint = 
DISABLED

To

property.RuntimePlatform.0.NativeExecution.FTP.security_constraint = 
NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.Shell.security_constraint = 
NATIVE_JAVA

property.RuntimePlatform.0.NativeExecution.SQLPlus.security_constraint = 
NATIVE_JAVA

16. Connect to OWBSYS user and execute <owb-home>/owb/rtp/sql/stop_service.sql.

17. Connect to OWBSYS user and execute <owb-home>/owb/rtp/sql/start_service.sql.

18. Connect to database with sys user and execute the following procedures:

Note: Before executing these procedures modify  <SMTP SERVER> and 
<SMTP PORT> to appropriate values.

EXECUTE DBMS_NETWORK_ACL_ADMIN.CREATE_ACL('acl_for_owb_cc.xml',
'ACL for Control Center','OWBSYS', TRUE, 'connect');
EXECUTE
DBMS_NETWORK_ACL_ADMIN.ASSIGN_ACL('acl_for_owb_cc.xml',<SMPT
SERVER>, <SMPT PORT>);
COMMIT;

19. Execute the following:

SELECT acl,host,
DECODE(DBMS_NETWORK_ACL_ADMIN.check_privilege_aclid(aclid,
'OWBSYS', 'connect'),1, 'GRANTED', 0, 'DENIED', NULL) privilege
FROM dba_network_acls ;
You will see the following:
/sys/acls/acl_for_owb_cc.xml
<SMPT SERVER>
GRANTED

20. Connect to BIREPOWN user and run spl_exec_wf_prc.sql.

Note: spl_exec_wf_prc.sql is located in ../BI240/Scripts.

21. Connect to DWADM schema and execute spl_oms_snapshot_pkg.sql.

Note: spl_oms_snapshot_pkg.sql is located in ../BI240/Scripts.

22. Connect to database with sys user and execute the following SQL statements:
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DROP SYNONYM DWADM.WB_RT_AUDIT;
CREATE SYNONYM DWADM.WB_RT_AUDIT FOR OWBSYS.WB_RT_AUDIT;
GRANT SELECT ON OWBSYS.WB_RT_AUDIT TO DWADM;
GRANT SELECT ON OWBSYS.ALL_RT_AUDIT_EXECUTIONS TO DWADM;
GRANT ALL ON OWBSYS.WB_RT_AUDIT_PURGE TO DWADM;
GRANT ALL ON OWFMGR.WF_PURGE TO DWADM;
GRANT SELECT_CATALOG_ROLE TO BIREPOWN;
GRANT ALL ON OWBSYS.WB_RT_AUDIT_EXECUTIONS TO DWADM;
GRANT ALL ON OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS TO DWADM;
DROP SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS;
DROP SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS;
CREATE SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS FOR
OWBSYS.WB_RT_AUDIT_EXECUTIONS;
CREATE SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS FOR
OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS;
alter system set query_rewrite_enabled=force;
alter system set query_rewrite_integrity=trusted;

OUASA ETL Package Installation Steps
Follow these steps to install the OUASA Package applications after performing the steps to deploy 
the ETL Component Objects as described in the section above:

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory. 

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Oracle Database Enterprise Edition 11.2.0.2 Installed User should be having privilege to 
install OUASA Package.

4. Execute the following script:

For UNIX:

export  ORACLE_CLIENT_HOME=<oracle_client_home>

export  PERL_HOME=$ORACLE_CLIENT_HOME/perl

export  PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set  ORACLE_CLIENT_HOME=<oracle_client_home>

set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set  PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the required execute permission on 
install_OUBI.sh.

5. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

6. Under the Installation Options, enter OWB.

7. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for ETL Component Installation.

************************************************

Environment Installation Options: *

************************************
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1.
       Oracle Client Home Directory:
       Installation Options:

2.
       Environment Mount Point:                 
       Log Files Mount Point:                   
       Environment Name:                        
       Web Java Home Directory:                 
       Database Home Directory:                 
       Database Type:                           oracle

Each item in the above list should be configured for a successful 
install.

Choose option (1,2, <P> Process, <X> Exit):

*****************************

* Environment Configuration *

*****************************

1. Environment Description
       Environment Description:                           

2. OBIEE Environment Configuration

3. Database Configuration
       OWB WorkSpace Owner:                              
       OWB WorkSpace Owner Password:                      
       Database Name:                                     
       Database Server:                                   
       Database Port:                                     

4. DESIGN REPOSITORY CONFIGURATION
       OWB WorkSpace User:                                
       OWB Workspace user Password:                       
       OWB WorkSpace Name:                                
       DWADM SCHEMA NAME:                                 
       DWADM SCHEMA Password:                             
       WORKFLOW MANAGER SCHEMA NAME:                      
       WORKFLOW MANAGER SCHEMA Password:                 

5. DATABASE CHARACTER SET CONFIGURATION
       Database Character set:                            AL32UTF8

6. EDITING PROCESS FLOW CONFIGURATION
       Repository Operating System:                       
       Perl Compiler location:                            
       Data and control files location:                   
       Separator to be used:                              
       File Manager location:                             

7. EMAIL CONFIGURATION
       Email ID of Sender:                                
       Email ID for Reply-To address:                     
       Email ID of Receiver:                              
       SMTP server:                                       
       SMTP server port:                                  
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8. CONTROL CENTRE CONFIGURATION
       Repository Control Center Name:                    

9. EXTERNAL DATA SOURCE CONFIGURATION
       Path of the External Datasource:                   
       Path of the External Datasource LOG:               
       File Processor Daemon Execution Switch:            1
       File Processor Extract Max Load:                   5
       File Processor Scheduler Poll Duration:            60

Each item in the above list should be configured for a successful 
install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

8. When you are done with the parameter setup, proceed with the option P. Write to the 
configure file.

9. Once the install has finished successfully, you execute the post-installation steps as described 
in Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

Deploying ETL Workflows on Oracle Warehouse Builder
Deploy the ETL work flows to target BI database configured in OUASA package installation.

In UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you may need to make change in OMBPlus.sh file, located at: $ORACLE_HOME/owb/bin/
unix/OMBPlus.sh

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M -
DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME -
DTCLLIBPATH="$TCLLIBPATH" -
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" -
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL" 
$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

You may need to make this value larger than 1024MB (1GB) depending on the size of the import.

Perform the following tasks:

• Deploying OWB Workflows

• Deploying Materialized Views

• Generating Security

• Generating Database Statistics

Deploying OWB Workflows
Review the parallel-* .txt files located under the $SPLEBASE/etc folder to set the degree of 
parallelism. The files are in the parallel*.txt format to change the <Degree> of parallelism.

parallel-tables.txt file format: <Object_name>:<Degree>

parallel-mvs.txt file format: <MV_Name>:<Fact_Table>:<Degree>

parallel-maps.txt file format: <Object_name>:<Table_Name>:<Degree>

For UNIX:
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Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

Run Ksh ./Owbdeploy.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run Owbdeploy.cmd

Deploying Materialized Views
For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

Run Ksh ./ installViews.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run installViews.cmd

Once the deployment is completed, remove the $SPLEBASE/tmp content to ensure all the 
complete files are removed.

cd $SPLEBASE/tmp

Generating Security
Edit the database name with the name of your database in OraGenSec.bat after completing the 
OWB deployment and run it from BI240/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA Dashboard Component Installation
This section describes how to install the database component of Oracle Utilities Advanced Spatial 
and Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
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Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the application server host (where OBIEE 11.1.1.5.0 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package. Install the JDK that is supported for 
the install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment it is recommended that you take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

OUASA Dashboard Package Installation Steps
Note: Before installing verify that the steps in Prerequisite Software for 
OUASA Dashboard Component are followed.
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To install the OUASA Dashboard Package, follow these steps. 

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set  PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set  PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install_OUBI.sh.

4. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

5. Under the Installation Options, enter “OBIEE”.

6. Select each menu item to configure the values. For detailed description of the values, see 
Configuration Worksheet for Dashboard Component Installation.

************************************

* Environment Installation Options *

************************************

1.
       Oracle Client Home Directory:                      
       Installation Options:                              
2.
       Environment Mount Point:                           
       Log Files Mount Point:                             
       Environment Name:                                  
       Web Java Home Directory:                           
       Database Home Directory:                           
       Database Type:                                     oracle

Each item in the above list should be configured for a successful 
install.

Choose option (1,2, <P> Process, <X> Exit):

In the environment configuration describes below, only 1 and 2 menu items are required to be 
configured. For detailed description of the values, see Configuration Worksheet for Dashboard 
Component Installation.

*****************************

* Environment Configuration *
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*****************************

1. Environment Description
       Environment Description:

2. OBIEE Environment Configuration
       Oracle BI Instance Home:
       Oracle BI Home:
       Oracle BI Domain Home:
       Weblogic Domain Console User Name:
       Weblogic Domain Console Host:
       Weblogic Domain Console Port Number:

3. Database Configuration

4. DESIGN REPOSITORY CONFIGURATION

5. DATABASE CHARACTER SET CONFIGURATION

6. EDITING PROCESS FLOW CONFIGURATION

7. EMAIL CONFIGURATION

8. CONTROL CENTRE CONFIGURATION

9. EXTERNAL DATA SOURCE CONFIGURATION
       Path of the External Datasource LOG:

Each item in the above list should be configured for a successful 
install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

When you are done with the parameter setup, proceed with the option P. Write the configuration 
file. Once the installation is completed successfully, you will need to execute post-installation steps 
as described in Post-installation Tasks.

Post-installation Tasks
The following post-installation tasks are discussed in this section:

• Deploying Repository (RPD) File

• Deploying Web Catalog

• Configuring and Deploying MapViewer

• Modifying instanceconfig.xml

• Deploying Custom MapViewer

• Deploying Write Back

• Deploying Analytics

• Enabling Analytics Help

Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd, where 
<install_dir> is the OUASA dashboard package installation directory.

To deploy the repository (RPD) file, follow these steps:

1. OBIEE 11.1.1.5.0 should have been installed on Windows 32-bit machine before proceeding 
with the steps below.
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2. Launch the Administration Tool from your Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > Administration.

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, “oracle123”. 

5. Edit the connection pools shown below by double clicking on them. 
.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name
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User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password. 

11. Click Save.

12. Login into OBIEE Enterprise Manager.

13. Navigate to BI Instance > Coreapplication > Deployment.

14. Lock and edit.

The repository text box will be enabled.

15. Browse to the modified rpd file and submit. The file is in the following location, where 
<install_dir> is the OUASA dashboard package installation directory.

<Install_Dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd

16. Provide the RPD password “oracle123” click Apply.

17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying Web Catalog
To deploy the Web catalog, follow these steps:
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For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploycatalog.sh

Enter the location of the physical catalogs configured in Enterprise Manager. For 
example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploycatalog.cmd

Enter the location of the physical catalogs configured in Enterprise Manager. For 
example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/ 
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

Configuring and Deploying MapViewer
To configure and deploy MapViewer, follow these steps:

• Configure MapViewer

• Modify instanceconfig.xml

• Deploy Custom MapViewer

Configuring MapViewer - 

To configure MapViewer, follow these steps:

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following details:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.
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9. Enter the following Connection properties:

Database Name:BI Database Name

Host Name:Database host

Port:Database port

Database User Name:dwadm

Password:dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : < OBIEE_INSTALL_DIR >/Oracle_BI1/bifoundation/jee/
mapviewer.ear/

web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.n

et,de.tiles.weatherbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example: FileLocation:

For UNIX:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modifying instanceconfig.xml
Update the security node with the following values. If the security Node is not present, add the 
following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>
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Deploying Custom MapViewer
To deploy the custom MapViewer, follow these steps:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploymapviewer.sh

Enter the WebLogic Domain Console password. For example, weblogic123

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

deploymapviewer.cmd

Enter the WebLogic Domain Console password. For example, weblogic123

Perform the following steps after deploying the custom MapViewer:

1. Update MapViewer configuration by navigating to MapViewer > Administration >

Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate parameters.

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"

/>

3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
The purpose of the write back templates enable the user to allow and configure Administrative 
dashboards. This is mandatory for the Admin dashboard functionality to work.

To deploy the write back feature, follow these steps:

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\
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coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element:

<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploywriteback.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploywriteback.cmd

Deploying Analytics
To deploy the analytics, follow these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/

coreapplication_obips1

2. Add the following before the end tag </ServerInstance>:

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help
To enable the Analytics' help, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics User Guide from 
Oracle Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.

3. Run the following commands:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deployanalyticsear.sh
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Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deployanalyticsear.cmd

Enter the WebLogic Domain Console Password. For example, weblogic123

4. Restart the BI Core services.

5. Restart WebLogic and all BI services after the OBIEE deployment is completed.

6. Log in to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database. 

7. Click Denied:Authenticated User and select Granted.

After the Installation
Ensure that the following tasks are performed after installing Oracle Utilities Advanced Spatial 
and Operational Analytics version 2.4.0:

1. For  OUASA ETL related post-installation tasks, see OUASA ETL Component 
Installation.

2. For OUASA dashboard related post-installation tasks, see OUASA Dashboard Component 
Installation.

3. For configuring the mapping and other parameters, refer to the Oracle Utilities Advanced Spatial 
and Operational Analytics Administration Guide.

4. Start File Processor Daemon.

5. Verify install and deploy logs:

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log 

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

OWB deploy logs:

<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt 

Custom Mapviewer deploy logs:

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

WriteBack logs:

<INSTALL_DIR>/logs/system/Writeback.log

FileProcessorDaemon logs:

<INSTALL_DIR>/bin/FileProcessorDaemon.log

6. Log into the OBIEE analytics link pointing to the demo database. The dashboard should 
display data with no errors.
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Chapter 7 
Installing OUASA v2.4.0 Service Pack 4

This chapter provides instructions for installing Oracle Utilities Advanced Spatial and Operational 
Analytics v2.4.0 (OUASA v2.4.0) Service Pack 4.

This chapter describes the following:

• Installation Types

Installation Types
The following installation types are supported:

• Initial Installation or Installing OUASA v2.4.0 Service Pack 4 from scratch

• Upgrading OUASA v2.4.0 or v2.4.0.x to OUASA v2.4.0 Service Pack 4

• Demo Installation

Initial Installation or Installing OUASA v2.4.0 Service Pack 4 from scratch
For customers installing OUASA v2.4.0 Service Pack 4 for the first time, they need to follow the 
install procedures in the sequence described below:  

• Installing OUASA Base Product v2.4.0

• Upgrading OUASA v2.4.0 to OUASA v2.4.0 Service Pack 4

Installing OUASA Base Product v2.4.0
Each of the following components should be installed during an initial installation.

• OUASA Database component 

• OUASA ETL component based on OWB

• OUASA Dashboard component based on OBIEE

For details on how to install the above components, refer to chapter Installing OUASA v2.4.0 
Base Installation.

Upgrading OUASA v2.4.0 to OUASA v2.4.0 Service Pack 4
Refer to section Upgrading OUASA v2.4.0 or v2.4.0.x to OUASA v2.4.0 Service Pack 4 below 
for upgrading OUASA v2.4.0 to OUASA v2.4.0 Service Pack 4 (OUASA v2.4.0.4). 
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Upgrading OUASA v2.4.0 or v2.4.0.x to OUASA v2.4.0 Service Pack 4
This section describes upgrade tasks and procedures for upgrading from Oracle Utilities 
Advanced Spatial and Operational Analytics (OUASA) v2.4.0 or v2.4.0.x to OUASA v2.4.0 
Service Pack 4.

• OUASA v2.4.0 Service Pack 4 Upgrade Installation

• Oracle Utilities Business Intelligence (OUBI) Upgrade Installation

Note: To upgrade to OUASA v 2.4.0 Service Pack 4, customers must have 
OUASA v2.4.0 or v2.4.0.x already installed on their systems.  If customers want 
to upgrade from earlier release versions of OUASA v2.4.0 to OUASA v2.4.0 
Service Pack 4, then they must first upgrade to OUASA Base Product v2.4.0.

Refer to chapter Upgrading to OUASA v2.4.0 Base Installation for details. 

OUASA v2.4.0 Service Pack 4 Upgrade Installation
Note: Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 or 
v2.4.0.x is a prerequisite for installing Oracle Utilities Advanced Spatial and 
Operational Analytics v2.4.0 Service Pack 4.

Following upgrade tasks must be completed:

• OUASA v2.4.0 Service Pack 4 Database Package Installation

• OUASA v2.4.0 Service Pack 4 Database Package Post-Installation

• OUASA v2.4.0 Service Pack 4 ETL Package Installation

• OUASA v2.4.0 Service Pack 4 Dashboard Package Installation

Note: All the scripts in the commands given below are written for both Unix 
and Windows environment. Hence, if you are using Unix,use the./sh script and 
for Windows, use .cmd respectively.

OUASA v2.4.0 Service Pack 4 Database Package Installation
If customers want to upgrade from 11.2.0.2 database to 11.2.0.3 database, they must first upgrade 
to database to 11.2.0.3 version before proceeding further.

Perform the following steps to complete this installation: 

1. Go to the directory having OUASA v2.4.0.4 downloaded package. 

2. Unzip the OUASA-V2.4.0.4-Database-Multiplatform.zip and it will have BI2404 folder.

3. Copy BI2404 folder to window 32 bit box having Oracle 11.2.0.2 client and Java 
Development Kit Version 6.0 Update 20 or later.

4. Take a back up of the existing OUASA database.

5. Go to ..\BI2404\DWADM\Install-Upgrade folder and run CDXDBI.exe from command 
prompt.  
This utility prompts you to enter values for the following parameters:

• The name of the target database.: <DB NAME>

• The password for the SYSTEM user account in the database (in silent mode).

• The name of the owner of the Database Schema.:<DWADM>

• The location of Java Home.: <..\jdk1.6.0_20>

• The location of TUGBU Jar files: <..\BI2404\DWADM\jarfiles>

• The password for the user (in silent mode).
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• The Oracle user with read-write privileges to the Database Schema.:<DWUSER>

• The Oracle user with read-only privileges to the Database Schema.:<DWREAD>

• The Oracle database role with read-write privileges to the Database  
Schema.:<DW_USER>

• The Oracle database role with read-only privileges to the Database 
Schema.:<DW_READ>

6. Connect to BIREPOWN user and run spl_exec_wf_prc.sql.

Note: spl_exec_wf_prc.sql is located in ..\BI2404\Scripts

7. Connect to DWADM schema and execute spl_oms_snapshot_pkg.sql.

Note: spl_oms_snapshot_pkg.sql is located in ..\BI2404\Scripts

Spatial Configuration
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Advanced Spatial and Operational Analytics.

Use the following procedure to load spatial metadata in the target database. If spatial data is 
already configured in application, follow the steps below: 

1. Create the dump_dir directory in database if already not created and copy user_sdo.dmp file 
from ..\B12404\Spatial-Metadata folder to directory location.Import released spatial tables 
to the target database using following command:  
 
impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=imp_user_sdo.log 
schemas=DWADM

Note: Run this command from database server.

2. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

3. After importing the tables, run following SQL scripts from the ..\B12404\Spatial-Metadata 
folder:

• sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

• sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sq

4. Review the log files.

OUASA v2.4.0 Service Pack 4 Database Package Post-Installation
For customers who are upgrading from Oracle Utilities Advanced Spatial and Operational 
Analytics (OUASA) v2.4.0 to OUASA v2.4.0 Service Pack 4, these upgrade scripts are applicable.

In earlier release version of OUASA v2.4.0, the DSI values coming from the source applications of 
Oracle Utilities Meter Data Management(MDM) and Oracle Utilities Mobile Workforce 
Management(MWM) could be manually configured. The 'General System Configuration' feature 
was used to this.

However, from OUASA v2.4.0 Service Pack 4 release onwards, the DSI values coming from these 
source applications will be based on the Environment ID available in the F1_INSTALLATION 
table.

Note: Customers who have manually configured the DSI value in their source 
applications of MDM or MWM must run these upgrade scripts. These scripts 
will rollback the DSI values on the data that has been loaded into the BI data 
warehouse. 

For these upgrade scripts, customers will have to input the new DSI value for each of the source 
application of MDM or MWM. The new DSI value must be the Environment ID available in the 
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source application. This can be retrieved by running the below query in the respective source 
application database. 

1. Select ENV_ID from F1_INSTALLATION;"

2. MDM Customers need to run ...\BI2404\DWADM\Post-
Upgrade\MDM_DSI_Upgrade_Script.sql after connecting to OUASA database.e.g

• sqlplus <DWADM>/<DWADM>@DBNAME

• SQL>@MDM_DSI_Upgrade_Script.sql

3. Enter the new Data Source Indicator value for MDM source application:<Result of query 
"select ENV_ID from F1_INSTALLATION" after connecting to MDM database>.

4. MWM Customers need to run ...\BI2404\DWADM\Post-
Upgrade\MWM_DSI_Upgrade_Script.sql after connecting to OUASA database, for 
example:

• sqlplus <DWADM>/<DWADM>@DBNAME

• SQL>@MWM_DSI_Upgrade_Script.sql

5. Enter the new Data Source Indicator value for MWM source application:<Result of query 
"select ENV_ID from F1_INSTALLATION" after connecting to MWM database>

OUASA v2.4.0 Service Pack 4 ETL Package Installation
Note: Before proceeding, apply the Oracle Warehouse Builder (OWB) patch 
13533924 to 11.2.0.2 Oracle Home if already not applied. Ensure to take a back 
up of the Workspace before applying the patch.

If customers want to upgrade from 11.2.0.2 database to 11.2.0.3 database, then they must first 
upgrade the database to 11.2.0.3 version and then follow the Oracle Warehouse Builder (OWB) 
cloning steps mentioned in the Oracle Utilities Advanced Spatial and Operational Analytics Administration 
Guide before proceeding further.

Perform the following steps: 

1. Log in to the server host where OUASA ETL package is installed.

2. Connect to OUASA database as sys user and restart the database.

3. Go to  $ORACLE_HOME/owb/rtp/sql and execute stop_service.sql and start_service.sql 
after logging as OWBSYS user.

4. Create a temporary directory such as c:\ouaf\temp or /ouaf/temp. 
 (Referred to below as <TEMPDIR>.) This directory must be located outside any current 
working Oracle Utilities application environment. All files that are placed in this directory as a 
part of the installation can be deleted after completing a successful installation.

5. Go to directory having OUASA v2.4.0.4 downloaded package.Unzip the Oracle Utilities 
Advanced Spatial and Operational Analytics V2.4.0.4 Multiplatform.zip. 
It will have OUASA-V2.4.0.4-MultiPlatform.jar file .  
Copy the file OUASA-V2.4.0.4-MultiPlatform.jar to the <TEMPDIR>. If you are using FTP 
to transfer this file, remember to use the BINARY option for the FTP transfer. 

6. Decompress the file:

• cd <TEMPDIR>

• jar -xvf OUASA-V2.4.0.4-MultiPlatform.jar

Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package. Install the JDK that is supported for 
the install on your platform to be able to use the jar command.

7. It will extract package contents in OUBI.V2.4.0.4 directory.
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8. Make sure to give execute privileges to all executables in OUBI.V2.4.0.4 Directory. e.g> 
 chmod -R 777 OUBI.V2.4.0.4

9. Take a back up of the previously installed ETL package environment.

10. Then, log in to previously installed ETL package environment. 
Perform the following steps:

• Go to installed environment location e.g. 
cd /bi_oradata_01/QABlds/BI240_CANDIDATE_BLD 

• cd etc

• Open ENVIRON.INI file and get the value of SPLENVIRON variable. It will look like 
SPLENVIRON=BI240_CANDIDATE_BLD.  
Here BI240_CANDIDATE_BLD is the environment name.

• cd ../bin

• . ./splenviron.sh/cmd -e <ENVIRONMENT NAME>  e.g ./splenviron.sh/cmd  -e 
BI240_CANDIDATE_BLD

• cd bin

11. Run ksh ./stopFileprocessordaemon.sh/cmd to stop the running file processor. 
Wait for file processor to stop. e.g. 
 execute " ps -ef|grep File"  to verify file processor has been stopped.

12. Go to OUASA v2.4.0.4 installer location, i.e.,< 
cd <TEMPDIR>/OUBI.V2.4.0.4 

13. Execute the following script: 
For eg: 
UNIX: 
bash-3.2$ ksh ./install_OUBI.sh/cmd 
12/07/24:14:05:02 <info>  Product BI is already installed in the environment 
BI240_CANDIDATE_BLD 
12/07/24:14:05:02 <info>  Do you want to reinstall it? (Y/N):YEnvironment Configuration

It will display the below menu structure with already set values.

• ENVIRONMENT CONFIGURATION

• Environment Description: B1 240 QA CANDIDATE

• OBIEE ENVIRONMENT CONFIGURATION

• DATABASE CONFIGURATION

• OWB WorkSpace Owner:  BIREPOWN

• OWB WorkSpace Owner Password: ENC 
(JNgCFZSCQLBm0bueRLS3dHGSgrwwJBR41BOXRPRh3tA=) 

• Database Name: B12400Q1

• Database Server: tudevlv0335.us.oracle.com

• Database Port: 1521

• DESIGN REPOSITORY CONFIGURATION

• OWB WorkSpace User: BIREPO

• WB Workspace user Password: 
ENC(R8AOnz+NdInvq2lNdLHTRFTt4JHBwPNlBA/kfzVLdKA=)

• OWB WorkSpace Name: SPLBIREP

• DWADM SCHEMA NAME: DWADM
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• DWADM SCHEMA Password: 
ENC(1NZeq8KDiIOs6GKcOd0YpCy+NydcElnG28qcMtNFkAE=)

• WORKFLOW MANAGER SCHEMA NAME: OWFMGR

• WORKFLOW MANAGER SCHEMA Password: 
ENC(VPZHMBWgA637DRfElBV2MFRR70Va7f5lalg6M5yrH3I=)

• DATABASE CHARACTER SET CONFIGURATION

• Database Character set: AL32UTF8

• EDITING PROCESS FLOW CONFIGURATION

• Repository Operating System: Linux

• Perl Compiler location: /usr/bin/perl

• Data and control files location: /spl/BIDevelopment/b12400q1

• Separator to be used: /

• File Manager location: File Manager location

• EMAIL CONFIGURATION

• Email ID of Sender: owb@oracle.com

• Email ID for Reply-To address: abc.x@oracle.com

• Email ID of Receiver: abc.x@oracle.com

• SMTP server: internal-mail-router.oracle.com

• SMTP server port: 25

• CONTROL CENTER CONFIGURATION

• Repository Control Center Name: B12400Q1

• EXTERNAL DATABASE CONFIGURATION

• Path of the External Datasource: /spl/BIDevelopment/b12400q1

• Path of the External Datasource LOG: /spl/BIDevelopment/b12400q1

• File Processor Daemon Execution Switch: 1

• File Processor Extract Max Load: 20

• File Processor Scheduler Poll Duration: 60

Each item in the above list should be configured for a successful install. Choose option 
(1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):P <Select option P>

14. cd bin

15. Run ksh ./initialSetup.sh/cmd

16. Go to $SPLEBASE/tmp location and delete all contents. e.g   
rm -rf *

17. Go to $SPLEBASE/bin location and run ksh ./parallelSetup.sh/cmd analyze

18. Go to $SPLEBASE/bin location and run ksh ./parallelSetup.sh/cmd merge

19. Go to $SPLEBASE/bin location and run ksh ./Owbdeploy.sh/cmd

Note: If you have skipped the post-installation task for ETL component as 
suggested in Chapter OUASA v2.4.0 Service Pack 4 Install Instructions > 
Changes in Supported Platforms section for Oracle Enterprise Linux (OEL) 
6.2 and with Oracle 11.2.03/Windows Server R2 2008 64 bit with Oracle 
11.2.0.3, then execute the below command: 
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cd $SPLEBASE/bin Run Ksh ./ installViews.sh/cmd

20. Go to $SPLEBASE/bin and run ksh ./upgradeViews240-2403.sh/cmd  if upgrading from 
OUASA v2.4.0, v2.4.0.1 or v2.4.0.2 to v2.4.0.4

21. Log in to window machine where BI2404 folder is copied and run the OraGenSec.bat from 
..\BI2404\DWADM\Security location

22. Copy the ..\BI2404\Scripts\splfilemgr.plx file to File Manager location  as mentioned in the 
sixth menu option. e.g /bi_oradata_01/QABlds/fileprocessor

23. Gather the schema stats by excuting the "execute 
dbms_stats.gather_schema_stats('DWADM') " command after logging as sys user to database

24. Start the file processor after logging in to ETL package environment with below command: 
nohup ksh ./startFileprocessordaemon.sh >&1 & 
File process log can be found at $SPLEBASE/logs/system/FileProcessorDaemon.log

OUASA v2.4.0 Service Pack 4 Dashboard Package Installation
If customer are using 11.1.1.5 version of OBIEE and want to upgrade to 11.1.1.6.4 version of 
OBIEE,  they must follow the section "Steps to Upgrade with OBIEE 11.1.1.6.4" or else 
proceed with procedural steps mentioned below.

Perform the following steps: 

1. Go to the directory where OUASA v2.4.0 Service Pack 4 package is downloaded. 

2. Unzip the Oracle Utilities Advanced Spatial and Operational Analytics V2.4.0.4 
Multiplatform.zip. It will have OUASA-V2.4.0.4-MultiPlatform.jar

3. Log in to the server host where OBIEE software is installed..

4. Go to directory location where rpd is deployed, example:   
<Middleware Home>/instances/instance1/bifoundation/OracleBIServerComponent/
coreapplication_obis1/repository

5. Create a directory here to move existing RPDs if any , except deployed one, for example,  
mkdir old_rpds. 
You can see deployed rpd name after logging to em.  
Navigate to  Business Intelligence-->coreapplication-->Deployment-->Repository to 
see the deployed .rpd file.

6. Take a backup of the deployed RPD.

7. Create a temporary directory such as c:\ouaf\temp or /ouaf/temp.  
(Referred in below steps as <TEMPDIR>)  
This directory must be located outside any current working Oracle Utilities application 
environment.  
Note that all files that are placed in this directory as a part of the installation can be deleted 
after completing a successful installation.

8. Copy the file OUASA-V2.4.0.4-MultiPlatform.jar from the directory where OUASA 2.4.0.4 
package is downloaded to <TEMPDIR> location. 
If you are using FTP to transfer this file, remember to use the BINARY option for the FTP 
transfer. 

9. Decompress the file: 
cd <TEMPDIR> 
jar -xvf OUASA-V2.4.0.4-MultiPlatform.jar

Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package.  
Install the JDK that is supported for the install on your platform to be able to 
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use the jar command. 

10. This will extract package contents in OUBI.V2.4.0.4 directory.

11. Make sure to provide execute privileges to all executables in OUBI.V2.4.0.4 Directory, eg: 
chmod -R 777 OUBI.V2.4.0.4

12. Take back up of previously installed dashboard package environment.

13. Log in to previously installed dashboard package environment. And perform the following 
steps:

• Go to the installed environment location, for example, 
cd /orasw/QABlds/BI_2401_QA1_CANDIDATE

• cd etc

• Open ENVIRON.INI file and get the value of SPLENVIRON variable. It will look like 
SPLENVIRON=BI_2401_QA1_CANDIDATE . Here BI_2401_QA1_CANDIDATE 
is environment name.

• cd ../bin

• . ./splenviron.sh/cmd  -e <ENVIRONMENT NAME>  e.g ./splenviron.sh -e 
BI_2401_QA1_CANDIDATE

• cd bin

14. Go to 2.4.0.4 installer location, i.e.,  
cd <TEMPDIR>/OUBI.V2.4.0.4.

15. Execute the following script:

UNIX: 

ksh ./install_OUBI.sh/cmd
12/07/24:14:05:02 <info>  
Product BI is already installed in the
environmentBI_2401_QA1_CANDIDATE 
12/07/24:14:05:02 <info> 
Do you want to reinstall it?  
(Y/N): Y 
 
This will display the below menu structure with already set values.

• ENVIRONMENT CONFIGURATION

• Environment Description: BI 2401 CANDIDATE

• OBIEE ENVIRONMENT CONFIGURATION

• BI 2401 CANDIDATE: /orasw/MW_HOME/instances/instance1

• Oracle BI Home: /orasw/MW_HOME/Oracle_BI1

• Oracle BI Domain Home: /orasw/MW_HOME/user_projects/domains/
bifoundation_domain

• Weblogic Domain Console User Name: weblogic

• Weblogic Domain Console Host: tudevlv0337.us.oracle.com

• Weblogic Domain Console Port Number: 7001

• DATABASE CONFIGURATION

• DESIGN REPOSITORY CONFIGURATION

• DATABASE CHARACTER SET CONFIGURATION
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• EDITING PROCESS FLOW CONFIGURATION

• EMAIL CONFIGURATION

• CONTROL CENTER CONFIGURATION

• EXTERNAL DATA SOURCE CONFIGURATION

• Path of the External Datasource LOG: 

Each item in the above list should be configured for a successful install. Choose option 
(1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):P <Select option P>

16. cd bin

17. Run ksh ./initialSetup.sh/cmd

18. If customer has made changes to deployed RPD, merge the deployed RPD with OUASA 
2.4.0.4 released RPD, follow the step 19 and skip step 20 below in this procedure   .  
To merge the RPDs, perform the steps given below: 

• Create current,modified and original directories on machine where OBIEE 
administration tool can be run e.g (Win 32 machine).

• Copy the deployed rpd that is backed up in step 6 to modified directory.

• If customer is on OUASA v2.4.0 please copy the released 2.4.0 RPD to original directory. 
If customer is on OUASA v2.4.0.1 version please copy the released v2.4.0.1 RPD to  
original folder.

• Copy the released v2.4.0.4 RPD to current folder. To get 2.4.0.4 RPD  please login to 
dashboard env as mentioned in step 13 if already not logged in and get it from 
$SPLEBASE/Reports/rpd location.    

• Open the BI administration tool on window machine. Open the rpd placed in current 
folder in offline mode. Provide oracle123 as password.

• Go to File-->merge. Select Merge Type : Full Repository Merge, then select RPD 
from the original folder as original master repository. 
Provide oracle123 as password, select RPD from the modified folder as Modified 
repository and provide oracle123 as password.

• Merged repository is saved as "Save Merged Repository as"  location

• Click Next. 

• Select current as decision option and click Finish.

19. Now, open the merged RPD in OBIEE Administration tool and make database connections 
as mentioned below:

• In the Initializing Blocks Connection group please provide the below details for Init 
Block Connection Pool:

• Datasource name = <BI Database name?

• User name = DWREAD

• Password = <password>

• In the Initializing Blocks Connection group please provide the below details for init 
Blcok pool -MDM:

• Datasource name = <MDM database name>

• User name = CISUSER

• Password = <password>

• In the ODIDEV Connection Pool group, provide the following:
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• Data source name = <BI database name>

• User name = DWUSER

• Password = <password>

• In the Oracle Data Warehouse group, provide the following: 

• Data source name = <BI database name>

• User name = DWREAD

• Password = <password>

After making database connection,save the RPD and check consistency. Ignore the 
warnings and  deploy the rpd from em console followed by OBIEE services restart and 
skip step 20 below.

20. If there are no customer changes in the deployed RPD ,log in to the OUASA dashboard  
environment and refer to step 13 to log in to environment.   
Open the RPD.  
rpd location : $SPLEBASE/Reports/rpd) in OBIEE Administration tool. 
 Provide password oracle123 and make database connections as mentioned below.

• In the Initializing Blocks Connection group please provide the below details for Init 
Block Connection Pool:

• Datasource name = <BI Database name>

• User name = DWREAD

• Password = <password>

• In the Initializing Blocks Con8nection group please provide the below details for init 
Blcok pool -MDM:

• Datasource name = <MDM database name>

• User name = CISUSER

• Password = <password>

• In the MDM Database Connection group, provide the following:

• Data source name = <MDM database name>

• User name = CISUSER

• Password = <password>

• In the ODIDEV Connection Pool group, provide the following:

• Data source name = <BI database name>

• User name = DWUSER

• Password = <password>

• In the Oracle Data Warehouse group, provide the following:

• Data source name = <BI database name>

• User name = DWREAD

• Password = <password>

After making database connection,save the rpd and check consistency. 
Ignore the warning messages and deploy the rpd from em console followed by OBIEE 
services restart. 

21. Log in to the OUASA dashboard environment.  
Refer to step 13 to log in to environment, if not logged in,  and delete below mentioned 
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catalogs from OBIEE instance before deploying the catalogs. Go to <Catalog location>/
root/shared folder and remove all non custom contents.

Note: Please log in to em to get catalog location.

"credit+&+collections+analytics.atr"

"credit+&+collections+analytics"

"shared+objects.atr"

"shared+objects"

"mobile+workforce+analytics.atr"

"mobile+workforce+analytics"

"administration.atr"

"administration"

"distribution+analytics.atr"

"distribution+analytics"

"revenue+analytics.atr"

"revenue+analytics"

"work+&+asset+analytics.atr"

"work+&+asset+analytics"

"about.atr"

"about"

"meter+data+analytics.atr"

"meter+data+analytics"

"co%6dmon.atr"

"co%6dmon"

"exception+analytics.atr"

"exception+analytics"

"customer+analytics.atr"

"customer+analytics"

"outage+analytics.atr"

"outage+analytics"

22. Run ksh ./deploycatalog.sh/cmd  
Provide catalog location e.g <Middleware_Home>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/SampleAppLite. 
Please confirm the catalog location after logging to em.

Note: Ensure to run the script from $SPLEBASE/bin location.

23. Go to <Middleware_Home>/Oracle_BI1/bifoundation/jee/mapviewer.ear/web.war/
WEB-INF/conf location.

• Take the back up of mapViewerConfig.xml. e.g 
cp mapViewerConfig.xml mapViewerConfig.xml.bkp

• Make sure to have <web_proxy host="www-proxy.us.oracle.com"  port="80" /> added in 
mapViewerConfig.xml if not exists. For example:
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 -->
<!--
<web_proxy host="www-proxy.my_corp.com"  port="80" />
-->
<web_proxy host="www-proxy.us.oracle.com"  port="80" /> 

•  If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node of mapViewerConfig.xml.

<proxy_enabled_hosts>        
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxb
ug.net,dev.tiles.weatherbug.com

</proxy_enabled_hosts>
 
For Example: 

<!-- Add remote URLs that this MapViewer's built-in proxy servlet
is allowed to communicate with. URLs should be separated by a 

comma.-->
   <proxy_enabled_hosts>

          localhost.com,http://www.localhost.com
  </proxy_enabled_hosts>
 
 <proxy_enabled_hosts>        
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api

.wxbug.net,dev.tiles.weatherbug.com
 </proxy_enabled_hosts>

</security_config> 

• Update the mapViewerConfig.xml with below node if it is not already updated

<ns_data_provider
id="obieeNsdp"

            class="com.oracle.utilities.birdseye.BirdseyeNSDP"
             />

For example:  

 -->
<!--

<ns_data_provider
id="defaultNSDP"    class="oracle.sdovis.NSDataProviderDefault"/>
<ns_data_provider
id="obieeNsdp"            

class="com.oracle.utilities.birdseye.BirdseyeNSDP"/>

• Update mapViewerConfig.xml with below node if it is not already updated

<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

For Example: 
 -->
<!--
<map_tile_server>
<tile_storage default_root_path="/scratch/maptiles/"/>
</map_tile_server>
-->
<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>
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• Add the below content with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"
jdbc_host="<DB_HOST>"
jdbc_sid="<DBNAME>"
jdbc_port="<DB_PORT>"
jdbc_user="<USER>"
jdbc_password="<!PASSWORD>"
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"/>

For example: 

<map_data_source name="MAPCONN"
jdbc_host="test.us.oracle.com"
jdbc_sid="TESTDB"
jdbc_port="1521"
jdbc_user="DWADM"
jdbc_password="!DWADM" 
jdbc_mode="thin"
number_of_mappers="32"                 

allow_jdbc_theme_based_foi="true"/> 

• cd $SPLEBASE/bin

• Run ksh ./deploymapviewer.sh/cmd and Enter Weblogic Domain Console Password <Please 
provide password>.

Note: Please make sure that script is run from $SPLEBASE/bin location.

24. Run ksh ./deploywriteback.sh/cmd

Note: Please make sure that script is run from $SPLEBASE/bin location.

25. Run ksh ./deployanalyticsear.sh/cmd and Enter Weblogic Domain Console Password 
<Please provide password>\

Note: Ensure to run the script from $SPLEBASE/bin location.

26. Restart the weblogic and OBIEE services.

Steps to Upgrade with OBIEE 11.1.1.6.4
Perform the following steps: 

1. Install  OBIEE 11.1.1.6.4 version.

2. Take the back up of 11.1.1.5 deployed rpd.

3. Copy the contents of <Catalog location>/root/shared folder from OBIEE 11.1.1.5 instance 
to <Catalog location>/root/shared folder of OBIEE 11.1.1.6.4 instance.

4. Copy the contents of <Catalog location>/root/system folder from OBIEE 11.1.1.5 instance 
to <Catalog location>/root/system folder of OBIEE 11.1.1.6.4 instance

5. Log in to the server host where OBIEE 11.1.1.6.4 software is installed and create a temporary 
directory such as c:\ouaf\temp or /ouaf/temp. (Referred to below as<TEMPDIR>.) This 
directory must be located outside any current working Oracle Utilities application 
environment. All files that are placed in this directory as a part of the installation can be 
deleted after completing a successful installation.

6. Copy the file OUASA-V2.4.0.4-MultiPlatform.jar from the directory having OUASA 2.4.0.4 
package downloaded to <TEMPDIR>. If you are using FTP to transfer this file, remember 
to use the BINRY option for the FTP transfer.
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7. Decompress the file: 
cd <TEMPDIR> 
jar -xvf OUASA-V2.4.0.4-MultiPlatform.jar

Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package. Install the JDK that issupported for 
the install on your platform to be able to use the jar command.

8. It will extract package contents in OUBI.V2.4.0.4 directory.

9. Make sure to give execute privileges to all executables in OUBI.V2.4.0.4 Directory. e.g 
 chmod -R 777 OUBI.V2.4.0.4

10. Go to 2.4.0.4 installer location i.e. 
cd <TEMPDIR>/OUBI.V2.4.0.4

11. . Execute the following : 

export ORACLE_CLIENT_HOME=<oracle_client_home>
export PERL_HOME=$ORACLE_CLIENT_HOME/perl
export PATH=$PATH:$PERL_HOME/bin
ksh ./install_OUBI.sh/cmd

12. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

13. Under the Installation Options, enter "OBIEE".

14. Select each menu item to configure the values.  
For detailed description of the values, see Configuration Worksheet for Dashboard Component 
Installation.

• Environment Installation Options

• Oracle Client Home Directory:

• Installation Options:

• Environment Mount Point:

• Log Files Mount Point:

• Environment Name:

• Web Java Home Directory:

• Database Home Directory:

• Database Type: oracle

Each item in the above list should be configured for a successful install.

Choose option (1,2, <P> Process, <X> Exit):

In the environment configuration describes below, only 1 and 2 menu items are required 
to be configured. For detailed description of the values, see Configuration Worksheet for 
Dashboard Component Installation.

• Environment Configuration 

• Environment Description

• OBIEE Environment Configuration

• Oracle BI Instance Home:

• Oracle BI Home:

• Oracle BI Domain Home:

• Weblogic Domain Console User Name:

• Weblogic Domain Console Host:
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• Weblogic Domain Console Port Number:

• Provide OBIEE Version Installed:                   

• Database Configuration

• DESIGN REPOSITORY CONFIGURATION

• DATABASE CHARACTER SET CONFIGURATION

• EDITING PROCESS FLOW CONFIGURATION

•  EMAIL CONFIGURATION

• CONTROL CENTRE CONFIGURATION

•  EXTERNAL DATA SOURCE CONFIGURATION

• Path of the External Datasource LOG:

Each item in the above list should be configured for a successful install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

When you are done with the parameter setup, proceed with the option P. 

15. If customer has made changes to 11.1.1.5 deployed rpd , merge the deployed rpd with 
OUASA v2.4.0.4 released rpd , follow the step 16 and skip the step 17 . Follow below steps to 
merge the rpds.

• Create current,modified and original directories on machine where OBIEE 
administration tool can be run e.g (Win 64bit  machine).

• Copy the deployed rpd that is backed up in step 2 to modified directory.

• If the customer is on OUASA v2.4.0, copy the released 2.4.0 rpd to original directory. If 
the customer is on OUASA v2.4.0.1 version, then copy the released 2.4.0.1 rpd to 
original folder.

• Copy the released 2.4.0.4 rpd to current folder. To get 2.4.0.4 rpd  please login to 
dashboard env as mentioned  if already not logged in and get it from $SPLEBASE/
Reports/rpd location.

• Open the OBIEE 11.1.1.6.4 BI administration tool on window machine. Open the rpd 
placed in current folder in offline mode. Provide oracle123 as password.

• Go to File-->merge and select Merge Type : Full Repository Merge, select rpd from 
original folder as original master repository ,provide oracle123 as password, select rpd 
from modified folder as Modified repository and provide oracle123 as password.

• Merged repository will be saved as Save Merged Repository location.

• Click Next. 

• Select current as decision option and click on Finish button.

16. Now open the merged rpd in OBIEE Administration tool and make database connections as 
mentioned below.

• In the Initializing Blocks Connection group please provide the below details for Init 
Block Connection Pool:

• Datasource name = <BI Database name?

• User name = DWREAD

• Password = <password>

• In the Initializing Blocks Connection group please provide the below details for init 
Blcok pool -MDM:
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• Datasource name = <MDM database name>

• User name = CISUSER

• Password = <password>

• In the MDM Database Connection group, provide the following 

• Data source name = <MDM database name>

• User name = CISUSER

• Password = <password>

• In the ODIDEV Connection Pool group, provide the following:

• Data source name = <BI database name>

• User name = DWUSER

• Password = <password>

• In the Oracle Data Warehouse group, provide the following:

• Data source name = <BI database name>

• User name = DWREAD

• Password = <password>

After making database connection,save the rpd and check consistency, please ignore the warnings 
and  deploy the rpd from em console followed by OBIEE services restart and skip step 17.

17. If there are no customer changes in deployed rpd ,log in to the OUASA dashboard  
environment ,open the rpd (rpd location : $SPLEBASE/Reports/rpd) in 11.1.1.6.4 OBIEE 
Administration tool, provide password oracle123 and make database connections as 
mentioned below.

•  In the Initializing Blocks Connection group, provide the below details for Init Block 
Connection Pool:

• Datasource name = <BI Database name?

• User name = DWREAD

• Password = <password>

• In the Initializing Blocks Connection group, provide the below details for init Blcok pool 
-MDM:

•         Datasource name = <MDM database name>

• User name = CISUSER

• Password = <password>

• In the MDM Database Connection group, the following: 

• Data source name = <MDM database name>

• User name = CISUSER

• Password = <password>

• In the ODIDEV Connection Pool group, provide the following:

• Data source name = <BI database name>

• User name = DWUSER

• Password = <password>

• In the Oracle Data Warehouse group, provide the following:
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• Data source name = <BI database name>

• User name = DWREAD

• Password = <password>

After making database connection,save the rpd and check consistency, please ignore the warnings 
and  deploy the rpd from em console followed by OBIEE services restart.

18. Log in to the OUASA dashboard environment if not already logged in,  and delete the below 
mentioned catalogs from OBIEE 11.1.1.6.4 instance before deploying the catalogs. Go to 
<Catalog location>/root/shared folder and remove all non custom contents.

Note:Please log in to em to get catalog location.

credit+&+collections+analytics.atr"

"credit+&+collections+analytics"

"shared+objects.atr"

"shared+objects"

"mobile+workforce+analytics.atr"

"mobile+workforce+analytics"

"administration.atr"

"administration"

"distribution+analytics.atr"

"distribution+analytics"

"revenue+analytics.atr"

"revenue+analytics"

"work+&+asset+analytics.atr"

"work+&+asset+analytics"

"about.atr"

"about"

"meter+data+analytics.atr"

"meter+data+analytics"

"co%6dmon.atr"

“co%6dmon"

"exception+analytics.atr"

“exception+analytics"

“customer+analytics.atr"

“customer+analytics"

“outage+analytics.atr"

“outage+analytics"

19. Run ksh ./deploycatalog.sh/cmd . Provide catalog location e.g <Middleware_Home>/
instances/instance1/bifoundation/OracleBIPresentationServicesComponent/
coreapplication_obips1/catalog/SampleAppLite. Confirm the catalog location after logging 
to em.
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Note: Make sure that script is run from $SPLEBASE/bin location and execute 
"export LD_BIND_NOW=1" before running deploycatalog.sh/cmd,  if using 
OEL 6.2.

20. Go to <Middleware_Home>/Oracle_BI1/bifoundation/jee/mapviewer.ear/web.war/
WEB-INF/conf location.

• Take the back up of mapViewerConfig.xml. e.g cp mapViewerConfig.xml 
mapViewerConfig.xml.bkp

• Ensure to have <web_proxy host="www-proxy.us.oracle.com"  port="80" /> added in 
mapViewerConfig.xml if not exists.

 -->
<!--

 <web_proxy host="www-proxy.my_corp.com"  port="80" />
  -->

<web_proxy host="www-proxy.us.oracle.com"  port="80" />

• If there is proxy used, insert the list of host names for all the third party service providers 
in the security_config node of mapViewerConfig.xml.

<proxy_enabled_hosts>
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,dev.tiles.we
atherbug.com

</proxy_enabled_hosts> 
for example: 

 <!-- Add remote URLs that this MapViewer's built-in proxy servlet
is allowed to communicate with. URLs should be separated by a comma.
 -->
  <proxy_enabled_hosts>

        localhost.com,http://www.localhost.com
 </proxy_enabled_hosts>

<proxy_enabled_hosts>
elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,dev.tiles.weather
bug.com

</proxy_enabled_hosts>
</security_config>

• Please update mapViewerConfig.xml with below node if not exists. 

<ns_data_provider
id="obieeNsdp"
class="com.oracle.utilities.birdseye.BirdseyeNSDP"
/>

e.g 
 -->
 <ns_data_provider
 id="defaultNSDP"
 class="oracle.sdovis.NSDataProviderDefault"
 />
ns_data_provider
id="obieeNsdp"
class="com.oracle.utilities.birdseye.BirdseyeNSDP"
/>

• Please update mapViewerConfig.xml with below node if not exists. 

<map_tile_server>
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<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

e.g.

-->
 <!--
<map_tile_server>
<tile_storage default_root_path="/scratch/maptiles/"/>
</map_tile_server>
-->
<map_tile_server>
<tile_storage default_root_path="/mytilecache/"/>
</map_tile_server>

• Add the below content with appropriate values: 

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>
<map_data_source name="MAPCONN"
jdbc_host="<DB_HOST>"
jdbc_sid="<DBNAME>"
jdbc_port="<DB_PORT>"
jdbc_user="<USER>"
jdbc_password="<!PASSWORD>"
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
>
e.g 

<map_data_source name="MAPCONN"
jdbc_host="test.us.oracle.com"
jdbc_sid="TESTDB"
jdbc_port="1521"
jdbc_user="DWADM"
jdbc_password="!DWADM" 
jdbc_mode="thin"
number_of_mappers="32"
allow_jdbc_theme_based_foi="true"
/>

• cd $SPLEBASE/bin

• Run ksh ./deploymapviewer.sh/cmd and Enter Weblogic Domain Console Password 
<Please provide password>.

Note: Please make sure that script is run from $SPLEBASE/bin location.

21. Create the MAP_DS data source

• Login to WebLogic console.

• In the WebLogic console, create the 'MAP_DS' data source.

• Lock and edit.

• Navigate to Services < Data Sources.

• Select New > Generic Data Source and provide the following details:

• Name = MAP_DS

• JNDI Name = MAP_DS

• Database Type = oracle
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• Click Next.

• Enter the following:

• Database Driver = XA thin database driver

• Click Next.

• Enter the following Connection properties:

• Database Name:BI Database Name

• Host Name:Database host

• Port:Database port

• Database User Name:dwadm

• Password:dwadm password

• Click Next and then click Finish.

• Click Activate Changes.

• Update the instance config file location, for example: 
FileLocation:<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

• Update the security node with the following values. If the security Node is not 
present, add the following code before </
Serverinstance>:<Security><ClientSessionExpireMinutes>210</
ClientSessionExpireMinutes><HttpOnlyCookies>false</
HttpOnlyCookies><CookieDomain /><CookiePath>/</CookiePath> </
Security>

• Update the following <ServerInstance> element <LightWriteback>true</
LightWriteback>

• Add the following before the end tag </ServerInstance>: 
<UI> <DefaultStyle>oubi</DefaultStyle> 
<DefaultSkin>oubi</DefaultSkin> 
</UI>

22. Run ksh ./deploywriteback.sh/cmd

Note: Please make sure that script is run from $SPLEBASE/bin location.

23. Run ksh ./deployanalyticsear.sh/cmd and Enter Weblogic Domain Console Password 
<Please provide password>

Note: Please make sure that script is run from $SPLEBASE/bin location.

24. Restart the weblogic and OBIEE services.

25. Log in to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database.

26. Click Denied:Authenticated User and select Granted.

Oracle Utilities Business Intelligence (OUBI) Upgrade Installation
If you have installed OUAF based application, i.e, an optional component of OUASA and want to 
upgrade to OUASA v2.4.0 Service Pack 4, then perform the procedural steps described below.

For this type of upgrade installation, customer must already be using either OUASA v2.4.0 or 
OUASA v2.4.0.x.
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OUB1 v2.4.0 Service Pack 4 Database Package Installation
Perform the following strep: 

1. Log in to window The location of Java Home.: <..\jdk1.6.0_20>machine where BI2404 
folder is copied.

2. Take bakc up of existing OUBI database.

3. Go to ..\BI2404\SPLADM\Install-Upgrade folder and run CDXDBI.exe from command 
prompt. This utility prompts you to enter values for the following parameters:

•   The name of the target database.:<DB NAME>

•  The password for the SYSTEM user account in the database (in silent mode)

•  The name of the owner of the Database Schema.:<SPLADM>

• The location of TUGBU Jar files: <..\BI2404\SPLADM\jarfiles>

•  The password for the user (in silent mode)

•  The Oracle user with read-write privileges to the Database Schema.:<SPLUSER>

• The Oracle user with read-only privileges to the Database Schema.:<SPLREAD>

• The Oracle database role with read-write privileges to the Database  
Schema.:<SPL_USER>

• The Oracle database role with read-only privileges to the Database 
Schema.:<SPL_READ>

4. Gather the schema stats by excuting the "execute 
dbms_stats.gather_schema_stats('SPLADM') " command after logging as sys user to 
database.  

Demo Installation
Note: Demo installation does not support ETL functionality.

This section describes how to install demo component of Oracle Utilities Advanced Spatial and 
Operational Analytics.

Refer to chapter  Demo Installation Procedure for details.

Note: Ensure to use OUASA v2.4.0 Service Pack 4 installer for demo 
installation and not the OUASA 2.4.0 installers.

For example, use OUASA-V2.4.0.4-Database-Multiplatform.zip database package instead of 
OUASA-V2.4.0-Database-Multiplatform.zip database package and OUASA.V2.4.0.4-
MultiPlatform.jar instead of OUASA.V2.4.0-MultiPlatform.jar.

Note: Demo dump file import will end with one error (Job 
"SYSTEM"."SYS_IMPORT_SCHEMA_01" completed with 1 error(s)) 
Ignore the error message.

Spatial Configuration
Perform the following steps to configure Spatial Configuration: 

1. .Create the dump_dir directory in database if already not created and copy user_sdo.dmp file 
from ..\B12404\Spatial-Metadata folder to directory location.

2. Import released spatial tables to the target database using following command: 

impdp directory=dump_dir dumpfile=user_sdo.dmp

logfile=imp_user_sdo.log schemas=DWADM

Note: Run this command from the database server. 
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3. Review the imp_user_sdo.log file to ensure the tables were imported successfully

4. After importing the tables, run following SQL scripts from the ..\B12404\Spatial-Metadata 
folder:

• sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

• sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql 

After completing the above steps, review the log files.
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Upgrading to OUASA v2.4.0 Base Installation

This chapter provides instructions for upgrading to Oracle Utilities Advanced Spatial and 
Operational Analytics (OUASA) base installation version 2.4.0. 

The chapter includes the following topics: 

• Before You Install

• Supported Upgrade Paths

• Upgrade

• After the Installation

Before You Install
Refer to article 1391459.1 on My Oracle Support (https://support.oracle.com/) for latest updated 
information on Oracle Utilities Advanced Spatial and Operational Analytics installation.

Supported Upgrade Paths
Direct upgrade to Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 is 
supported from the following versions:

• Oracle Utilities Advanced Spatial and Operational Analytics version 2.3.2.1

For upgrading from a version not supported by direct upgrade path, the product should first be 
upgraded to OUASA v2.3.2.1 and then upgraded to OUASA v2.4.0.

Upgrade
This section describes the procedure to upgrade Oracle Utilities Advanced Spatial and 
Operational Analytics version 2.3.2.1 to version 2.4.0.

• OUASA Database Component Upgrade

• OUASA ETL Component Upgrade

• OUASA Dashboard Component Upgrade

OUASA Database Component Upgrade
This section describes the upgrade installation of the database. Upgrade the database to 
AL32UTF8 character set. Following topics are discussed in this section: 

• Copying and Decompressing Install Media
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• DWADM Schema Upgrade

• Security Configuration

• Spatial Configuration

• Generating Database Statistics

Copying and Decompressing Install Media
To copy and then decompress the install media, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics version 2.4.0 
Oracle Database part from Oracle Software Delivery Cloud. 

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA-V2.4.0-Database-Multiplatform.zip from the delivered package to the 
<TEMPDIR>.

4. Unzip the zip file using any zip utility.

DWADM Schema Upgrade
This section describes how to upgrade an existing OUASA v2.3.2.1 target schema to OUASA 
v2.4.0. The upgrade process prompts you for the names of three database users:

• A user that will own the application schema. For example, DWADM

• A user that has read-write (select/update/insert/delete) privileges to the objects in the 
application schema. The application will access the database as this user. For example, 
DWUSER

• A user with read-only privileges to the objects in the application schema. For example, 
DWREAD

The upgrade process also prompts you for the following:

• A database role that has read-write (select/update/insert/delete) privileges to the objects in 
the application schema. The application will access the database as this user. For example, 
DW_USER

• A database role with read-only privileges to the objects in the application schema. For 
example, DW_READ

• Location for jar files. (The Jar files are bundled with the database package.)

• Java Home. For example, C:\Java\jdk1.6.0_18

To upgrade the Oracle database, perform the following steps:

Note: Ensure to run CDXDBI.exe from a Window 32-bit desktop that has the 
Oracle 11.2.0.2 client and Java Development Kit Version 6.0 Update 20 or later.

Upgrade your database to AL32UTF8 character set.

1. Run CDXDBI.exe from ..\BI240\DWADM\Install-Upgrade. Please run this utility from 
command prompt. The utility prompts you to enter values for the following parameters:

Name of the target database.:<DB NAME>

Password for the SYSTEM user account in the database (in silent mode)

Name of the owner of the Database Schema:<DWADM>
Upgrading to OUASA v2.4.0 Base Installation 8-2 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Upgrade
Location of Java Home: <..\jdk1.6.0_20>

Location of TUGBU Jar files: <..\BI240\DWADM\Jarfiles>

Password for the user (in silent mode)

Oracle user with read-write privileges to the Database Schema:<DWUSER>

Oracle user with read-only privileges to the Database Schema:<DWREAD>

Oracle database role with read-write privileges to the Database Schema:<DW_USER>

Oracle database role with read-only privileges to the Database Schema:<DW_READ>

2. If you chose to continue, CDXDBI first checks for the existence of each of the users 
specified and prompts for their password, default tablespace, and temporary tablespace, if 
they do not exist.

3. After setting up roles and users, the utility continues upgrading schema and system data 
definitions. If an error occurs while executing an SQL or another utility, it logs and displays 
the error message and allows you to re-execute the current step.

4. Navigate to BI240/DWADM/Post-Upgrade folder and execute 
FieldMetadata_FeatureConfigMigrationScript.sql:

- sqlplus dwadm/dwadm@database-name 
@FieldMetadata_FeatureConfigMigrationScript.sql

5. Enter SPLADM at the following prompt:

Enter Application Schema Owner Name:(e.g SPLADM)

6. Connect to DWADM schema and execute the following sql:

update b1_configuration set override_value = ''
where feature_name = 'B1_MAPATTPRO' and option_code = 'B1DD';
Commit;

Security Configuration
The configuration utility and scripts are located in the Security folder.

To request grants for the DWADM schema, follow these steps:

1. Navigate to the ..\BI240\/DWADM\/Security folder.

2. Edit the file DWADM-OraGenSec.bat, which is in the same location, and replace the 
parameter database-name with the name of your database. This file is provided for your 
convenience and executes the Oragensec.exe utility based on the parameters passed into it.

Note: Ensure to run DWADM-OraGenSec.bat from a Window 32-bit desktop 
that has the Oracle 11.2.0.2 client installed. Your database should already be 
listed in the local file tnsnames.ora. The script executes as follows: 

oragensec -d DWADM,DWADM,database_name -r DW_READ,DW_USER -a A -u
SPLUSER,SPLREAD

3. Execute the edited DWADM-OraGenSec.bat file from command prompt. This utility 
configures the security for DWADM schema objects.

Spatial Configuration 
Note: See Spatial Configuration to configure spatial data if application has 
not been yet configured.

If spatial data is already configured in application please follow the steps below: This section 
describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities Advanced 
Spatial and Operational Analytics.
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Use the following procedure to load spatial metadata in the target database:

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1240/
Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=

imp_user_sdo.log schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1240/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

Generating Database Statistics
During an install process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA ETL Component Upgrade
This section describes the ETL component installation.

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• Configuring and upgrading Oracle Warehouse Builder Workspace

• Upgrading OUASA ETL Package

• Post-upgrade Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the database server host as the Oracle Utilities Advanced Spatial and Operational 
Analytics administrator user ID (default cases).

2. Create a temporary directory such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar
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Note: You must have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform in order to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html.

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you are planning to upgrade an existing environment it is your responsibility to take a backup 
prior to the installation process. The installation utility does not create a backup of existing 
environment.

Configuring and upgrading Oracle Warehouse Builder Workspace
This section describes the procedure to configure Oracle Warehouse Builder workspace.

To upgrade Oracle Utilities Advanced Spatial and Operational Analytics version 2.3.2.1 to version 
2.4.0, follow these steps:

1. Back up the database using the backup strategy employed at your site.

2. Apply 12874883 OWB patch to database server and OWB client if already not applied.

3. Connect to BIREPOWN user and run spl_exec_wf_prc.sql.

spl_exec_wf_prc.sql is located at ../BI240/Scripts.

4. Connect to the DWADM schema and execute spl_oms_snapshot_pkg.sql.

spl_oms_snapshot_pkg.sql is located at ../BI240/Scripts.

5. Connect to the database with sys user and execute the following SQL statements:

DROP SYNONYM DWADM.WB_RT_AUDIT;

CREATE SYNONYM DWADM.WB_RT_AUDIT FOR OWBSYS.WB_RT_AUDIT;

GRANT SELECT ON OWBSYS.WB_RT_AUDIT TO DWADM;

GRANT SELECT ON OWBSYS.ALL_RT_AUDIT_EXECUTIONS TO DWADM;

GRANT ALL ON OWBSYS.WB_RT_AUDIT_PURGE TO DWADM;
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GRANT ALL ON OWFMGR.WF_PURGE TO DWADM;

GRANT SELECT_CATALOG_ROLE TO BIREPOWN;

GRANT ALL ON OWBSYS.WB_RT_AUDIT_EXECUTIONS TO DWADM;

GRANT ALL ON OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS TO 
DWADM;

DROP SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS;

DROP SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS;

CREATE SYNONYM DWADM.WB_RT_AUDIT_EXECUTIONS FOR

OWBSYS.WB_RT_AUDIT_EXECUTIONS;

CREATE SYNONYM DWADM.WB_RT_DEF_EXECUTION_OPERATORS FOR

OWBSYS.WB_RT_DEF_EXECUTION_OPERATORS;

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

Upgrading OUASA ETL Package
Perform the below mentioned steps to upgrade OUASA package applications to deploy the ETL 
component objects. Note perform these steps after completing steps for upgrading Oracle 
Warehuse Builder as shown in the above section. 

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Oracle Database Enterprise Edition 11.2.0.2 Installed User should be having privilege to 
install OUASA Package.

4. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

5. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu is displayed.

6. Under the Installation Options, enter OWB.

7. Select the Each Menu Item to configure the values. For detailed description of the values 
see Configuration Worksheet for ETL Component Installation.
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************************************

* Environment Installation Options *

************************************

1.

       Oracle Client Home Directory:                      

       Installation Options:                              

2.

       Environment Mount Point:                           

       Log Files Mount Point:                             

       Environment Name:                                  

       Web Java Home Directory:                           

       Database Home Directory:                           

       Database Type:                                     oracle

Each item in the above list should be configured for a successful install.

Choose option (1,2, <P> Process, <X> Exit):

*****************************

* Environment Configuration *

*****************************

1. Environment Description

       Environment Description:                           

2. OBIEE Environment Configuration

3. Database Configuration

       OWB WorkSpace Owner:                              

       OWB WorkSpace Owner Password:                      

       Database Name:                                     

       Database Server:                                   

       Database Port:                                     

4. DESIGN REPOSITORY CONFIGURATION

       OWB WorkSpace User:                                

       OWB Workspace user Password:                       

       OWB WorkSpace Name:                                

       DWADM SCHEMA NAME:                                 

       DWADM SCHEMA Password:                             
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       WORKFLOW MANAGER SCHEMA NAME:                      

       WORKFLOW MANAGER SCHEMA Password:                 

5. DATABASE CHARACTER SET CONFIGURATION

       Database Character set:                            AL32UTF8

6. EDITING PROCESS FLOW CONFIGURATION

       Repository Operating System:                       

       Perl Compiler location:                            

       Data and control files location:                   

       Separator to be used:                              

       File Manager location:                             

7. EMAIL CONFIGURATION

       Email ID of Sender:                                

       Email ID for Reply-To address:                     

       Email ID of Receiver:                              

       SMTP server:                                       

       SMTP server port:                                  

8. CONTROL CENTRE CONFIGURATION

       Repository Control Center Name:                    

9. EXTERNAL DATA SOURCE CONFIGURATION

       Path of the External Datasource:                   

       Path of the External Datasource LOG:               

       File Processor Daemon Execution Switch:            1

       File Processor Extract Max Load:                         5

       File Processor Scheduler Poll Duration:            60

Each item in the above list should be configured for a successful install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

8. After completing the parameter setup steps, proceed with the option P. Write Configure file.

9. Once the install is completed successfully, you need to execute the post-upgrade steps as 
described in the section Post-upgrade Tasks.

Post-upgrade Tasks
Post-upgrade tasks include the following: 

• Deploying ETL Workflows on Oracle Warehouse Builder
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Deploying ETL Workflows on Oracle Warehouse Builder
In UNIX, you may get a Java heap space error while importing the MDL file. To resolve this error 
you need to make changes in the OMBPlus.sh file, located at: $ORACLE_HOME/owb/bin/
unix/OMBPlus.sh.

In the following code, change the value -Xmx768M to -Xmx1024M, and then the -Dlimit value 
768M to 1024M.

$JAVAPATH/bin/java $JAVA64FLAG -Xms64M -Xmx768M $OPTS -Dlimit=768M -
DORACLE_HOME=$ORACLE_HOME -DOWBCC_HOME=$ORACLE_HOME -
DTCLLIBPATH="$TCLLIBPATH" -
DMARATHON_RETRY_COUNT="$MARATHON_RETRY_COUNT" -
DMARATHON_RETRY_INTERVAL="$MARATHON_RETRY_INTERVAL" 
$CLASSPATH_LAUNCHER oracle.owb.scripting.OMBShell $*

You need to make this value larger than 1024MB (1GB) depending on the size of the import.

Perform the following tasks:

• Deploying OWB Workflows

• Deploying Materialized Views

• Generating Security

• Generating Database Statistics

Deploying OWB Workflows
This procedure needs to be performed if changes are made to the parallel settings on external 
tables, materialized views, or mappings on an existing installation and needs to be retained during 
the upgrade process.

Run the following command to generate a report on the parallel settings that is currently set in the 
customer repository on external tables, materialized views and mappings.

For UNIX:

Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./parallelSetup.sh analyze

For Windows:

Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

parallelSetup.cmd analyze

This generates the following files under <SPLEBASE>/etc folder:

cm-parallel-tables.txt

cm-parallel-mvs.txt

cm-parallel-maps.txt

Review the above files for existing settings and make modifications if necessary. Once the files are 
reviewed, perform the following step to merge the existing settings with the default settings.

For UNIX:

Initialize the environment by executing the ./splenviron.sh -e <envname> command.
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Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./parallelSetup.sh merge

For Windows:

Initialize the environment by executing the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

parallelSetup.cmd merge

Review the following files under <SPLEBASE>/etc and verify that the existing values have been 
merged correctly before proceeding:

parallel-tables.txt

parallel-mvs.txt

parallel-maps.txt

Below is the format of parallel*.txt to change the <Degree> of parallelism in above listed files.

parallel-tables.txt file format: <Object_name>:<Degree>

parallel-mvs.txt file format: <MV_Name>:<Fact_Table>:<Degree>

parallel-maps.txt file format: <Object_name>:<Table_Name>:<Degree>

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command. 

Note: Navigate to the Install_Dir/bin to initialize. 

cd $SPLEBASE/bin

Run Ksh ./Owbdeploy.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run Owbdeploy.cmd

Deploying Materialized Views
Run the following commands for deploying Materialized Views.

For UNIX:

Initialize the environment by executing the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

Run ksh ./upgradeViews.sh

For Windows:

Initialize the environment by executing the ./splenviron.cmd -e <envname> command.
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Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

Run upgradeViews.cmd

Once deployment process is completed, remove the $SPLEBASE/tmp content to ensure all the 
complete files are removed.

cd $SPLEBASE/tmp

Generating Security
Edit database-name with the name of your database in OraGenSec.bat after completing the OWB 
deployment and run it from BI240/DWADM/Security folder.

Generating Database Statistics
During the installation process, new database objects may be added to the target database. Before 
starting to use the database, generate the statistics for these new objects.

OUASA Dashboard Component Upgrade
This section describes the dashboard component installation and includes the following: 

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Upgrade Steps

• Upgrading RPD and Catalog Files

• Post-upgrade Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Log in to the application server host (where OBIEE 11.1.1.5.0 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You will need to have Java JDK installed on the machine used to (un)jar 
the application server installation package. Install the JDK that is supported for 
the install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html.
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A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Note that every Oracle Utilities Advanced Spatial and Operational Analytics environment installed 
on a server must be registered in the /etc/cistab file located on that server. 

On UNIX servers, generally only the root user ID has write permissions to the /etc directory. 
Since the installation process is run by the Oracle administrator user ID (cissys), this user ID may 
not be able to write to /etc/cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.

The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment, it is recommended that you take a backup before 
following the installation process. The installation utility does not create a backup of existing 
environment.

OUASA Dashboard Package Upgrade Steps
Before upgrading, verify that the steps in section Prerequisite Software for OUASA Dashboard 
Component are followed.

To upgrade the OUASA dashboard package, follow these steps. 

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set PATH=%PERL_HOME%\bin;%PATH%Install_OUBI.cmd

Note: On UNIX, ensure that you have the required execute permission on 
install.sh.

3. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

4. Under the Installation Options, enter OBIEE.
Upgrading to OUASA v2.4.0 Base Installation 8-12 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Upgrade
5. Select the Each Menu Item to configure the values. 
For detailed description of the values see Configuration Worksheet for Dashboard 
Component Installation.

************************************

* Environment Installation Options *

************************************

1.

      Oracle Client Home Directory:                      

       Installation Options:                              

2.

       Environment Mount Point:                           

       Log Files Mount Point:                             

       Environment Name:                                  

       Web Java Home Directory:                           

       Database Home Directory:                           

       Database Type:                                     oracle

Each item in the above list should be configured for a successful install.

Choose option (1,2, <P> Process, <X> Exit):

6. In the Environment Configuration worksheet mentioned below, only menu items 1 and 2 are 
required to be configured. For detailed description of the values see Configuration 
Worksheet for Dashboard Component Installation.

*****************************

* Environment Configuration *

*****************************

1. Environment Description

       Environment Description:

2. OBIEE Environment Configuration

       Oracle BI Instance Home:

       Oracle BI Home:

       Oracle BI Domain Home:

       Weblogic Domain Console User Name:

       Weblogic Domain Console Host:

       Weblogic Domain Console Port Number:

3. Database Configuration

4. DESIGN REPOSITORY CONFIGURATION
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5. DATABASE CHARACTER SET CONFIGURATION

6. EDITING PROCESS FLOW CONFIGURATION

7. EMAIL CONFIGURATION

8. CONTROL CENTRE CONFIGURATION

9. EXTERNAL DATA SOURCE CONFIGURATION

       Path of the External Datasource LOG:

Each item in the above list should be configured for a successful install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):

7. After completing the parameter setup, proceed with the option P. 
Write the Configure file.

8. Once the install is finished successfully, you now need to execute post-installation steps as 
described in the section Upgrading RPD and Catalog Files.

Upgrading RPD and Catalog Files
If you have made custom changes to OBIEE 10g RPD and catalog files, follow the procedures in 
this section to make the custom files compatible with 11g. This section includes the following 
topics:

• Converting RPD Files

• Converting Catalogs

• Merging the RPD Files

Converting RPD Files
Perform these steps to convert the 10g RPD files to 11g:

1. Create a folder on the server where 11g OBIEE is installed.  
Copy the 10g RPD file that is deployed in your environment to this folder.

2. Go to $ORACLE_BI_HOME/bin and run ua.bat or ua.

3. Click Next to continue.

4. Select Upgrade Oracle BI RPD and Presentation Catalog.

5. Click Next to continue.

6. Select Upgrade repository.

7. Select the 10g RPD file contained in the folder that you created in step 1.

8. Enter the administrator User ID and password for the 10g RPD file.

9. Enter the new administrator password for 11g RPD, for example, oracle123.

10. Specify the WebLogic port and login details.

An 11g compatible rpd file will be created in the following location:

$ORACLE_INSTANCE /bifoundation/OracleBIServerComponent/
coreapplication_obis1/repository location.

11. Back up the converted rpd file from the deployed location.  
This is your changed rpd file.

Converting Catalogs
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Follow these steps to convert 10g catalog files to 11g:

1. Create a folder on the server where 11g OBIEE is installed. For example, obiee/
SampleAppLite.

2. Copy the contents of 10g ../../web/catalog/samplesales folder to the obiee/
SampleAppLitefolder.  The samplesales folder is included in the 10g application.

3. Create a folder named "deliveries" inside the OBIEE folder.

4. Navigate to $ORACLE_BI_HOME/bin and run ua.bat or ua.

5. Select Upgrade Oracle BI RPD and Web Catalog.

6. Click Next to continue.

7. Select Upgrade catalog.

8. Select the obiee/SampleAppLite folder as the catalog directory.

9. Select obiee/deliveries as the catalog deliveries directory.

10. Click Next.

11. Specify the WebLogic port and login details.

12. Click Next.

13. Click Upgrade. 
The 10g catalogs will be deployed at the following location:

$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServicesComponent/
coreapplication_obips1/catalog/SampleAppLite/root/shared location

Merging the RPD Files
Convert your 10g 2.3.2.1 original RPD file to 11g as described in the section Converting RPD 
Files on page 8-14. The backup of the converted RPD should be considered the original RPD.

After you have converted the RPD file, follow these steps to merge the BI 2.4 RPD file, the 
original BI 2.3.2.1 RPD file, and the changed BI 2.3.2.1 RPD file. You will use the resulting 
merged RPD file for deployment in the OBIEE 11g instance.

1. In the OBIEE Administration Tool, open the Current Repository (2.4 Release RPD).

2. From the File menu, select Merge.

3. Select Original repository (2.3.2 Release RPD).
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4. Select Modified Repository as 2.3.2 (Customer Modified) RPD.

5. Define the merge strategy.

Defining Merge Strategy
The following examples show the results of some decision choices when the current and modified 
repositories are different:

• If the Description column for an object contains Added to Current, the following are choices 
in the Decision column and their results:

• Selecting Current keeps the addition in the current repository.

• Selecting Modified (D) deletes the added object from the current repository.

• If the Description column for an object contains Deleted from Modified, the following are 
choices in the Decision column and their results:

• Selecting Current keeps the repository as is without deleting the object.

• Selecting Modified (D) deletes the object from the current repository.

• If the Description column for an object contains Deleted from Current, the following are 
choices in the Decision column and their results:
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• Selecting Current keeps the repository as is without adding the object back into the 
current repository.

• Selecting Modified (A) adds the object back into the current repository.

• If the Description column for an object contains Added to Modified, the following are 
choices in the Decision column and their results:

• Selecting Current keeps the repository as is without adding the object back into the 
current repository.

• Modified (A). Selecting Modified (A) adds the object back into the current repository.

After the Merge, newly added functionality and old CM computed columns are intact.

After upgrading the RPD and catalog files, you will need to execute the post-upgrade steps as 
described in Post-upgrade Tasks.

Post-upgrade Tasks
Post-upgrade tasks involve the following: 

• Deploying the Repository (RPD) File

• Deploying Web Catalog

• Configuring and Deploying MapViewer

• Deploying Write Back

• Deploying Analytics

Deploying the Repository (RPD) File
The RPD file is in the following location: <install_dir>/Reports/rpd/
UtilitiesBusinessAnalytics240.rpd, where <install_dir> is the OUASA dashboard package 
installation directory.

Follow these steps to deploy the RPD file:
Upgrading to OUASA v2.4.0 Base Installation 8-17 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Upgrade
1. OBIEE 11.1.1.5.0 should be installed on Windows 32-bit machine before proceeding with 
the below steps.

2. Launch the Administration Tool from your Start menu.

Start > Programs > Oracle Business Intelligence > Administration 

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, “oracle123”.

5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name
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User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD

Password = DWREAD User password

11. Click Save.

12. Login into OBIEE Enterprise Manager.

13. Navigate to BI Instance > Coreapplication > Deployment.

14. Lock and edit.

The repository text box will be enabled.

15. Browse to the modified rpd file and submit. The file is in the following location, where 
<install_dir> is the OUASA dashboard package installation directory.

<Install_Dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd

16. Provide the RPD password “oracle123”, and then click Apply.

17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in tnsnames.ora file in 
<OBIEE_INSTALL_DIR>/Oracle_BI1/network/admin.

Deploying Web Catalog
Note: You must delete the old BI v2.3.2.1 catalogs (if present in 11g OBIEE 
instance) before deploying the catalogs.
Upgrading to OUASA v2.4.0 Base Installation 8-19 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Upgrade
The deployment procedure should be run on your Windows client/server machine that has the 
OBIEE 11.1.1.5 client installed.

To delete the old catalogs, follow these steps:

1. Launch the Catalog Manager from your Start menu.

Start > Programs > Oracle Business Intelligence > Catalog Manager

2. From the File menu, select Open Catalog. The Open Catalog window is displayed.

3. Specify the following values:

1. From the Type drop-down, select Online.

2. Enter the URL to the analytics Web application in the following form:

http://<OBIEE Host>: <OBIEE Port>/analytics/saw.dll

3. Enter Administrator as the User and ASAadm as the Password.

4. Click OK to close the window.

5. In the tree panel, expand the root folder /.

6. Select the Shared folder.

7. Select the catalogs in the shared folder, right click, and then select Delete.

It will prompt for Physical Catalog location configured in Enterprise Manager. This is the server 
path where OBIEE is installed.
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To deploy the catalogs, follow these steps:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploycatalog.sh

Enter the physical catalogs location configured in Enterprise Manager. For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd  %SPLEBASE%\bin

deploycatalog.cmd

Enter the Physical Catalogs location configured in EM For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

Configuring and Deploying MapViewer
Configuring and deploying the MapViewer involves the following:

Configuring MapViewer - To configure MapViewer, follow these steps:

1. Login to the WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name:BI Database Name

Host Name:Database host

Port:Database port

Database User Name:dwadm
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Password:dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/
mapviewer.ear/web.war/WEB-INF/conf/

File: mapViewerConfig.xml

13. If there is a proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,de.tiles.wea
therbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example:

FileLocation:

For Unix :

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modify instanceconfig.xml - Update the security Node with the following values. If the 
security Node is not present, add following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer - To deploy the custom MapViewer, follow these steps:

For Unix:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.
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cd $SPLEBASE/bin

ksh ./deploymapviewer.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%\bin

deploymapviewer.cmd

Enter WebLogic Domain Console Password. For example, weblogic123

Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<!DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"

/>

3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
Follow these steps to deploy the write back feature.

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element according to the following code:

<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin
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ksh ./deploywriteback.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploywriteback.cmd

Deploying Analytics
To deploy analytics, follow these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

2. Add the following before the end tag </ServerInstance>

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help - To enable the analytics' help, follow these steps:

1. Download Oracle Utilities Advanced Spatial and Operational Analytics User Guide from Oracle 
Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.

3. Run the following commands:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deployanalyticsear.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deployanalyticsear.cmd

Enter the WebLogic Domain Console Password. For example, weblogic123

4. Restart the BI Core services.

5. Restart WebLogic and all BI services after the OBIEE deployment is completed.
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6. Login to Analytics and navigate to Administration>Manage Privileges>Write 
Back>Write Back to Database. 

7. Click Denied:Authenticated User and select the permission Granted.

After the Installation 
After the installation, perform the following: 

1. Verify theInstall and Deploy Logs.

• MDL Import Logs

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Project_imp.log 

<INSTALL_DIR>/OWB/MetadataFiles/SPL-BI-Location_imp.log

• OWB Deploy Logs

<INSTALL_DIR>/logs/system/log_OWBDeployment_YYYYMMDD_####.txt 

• Custom Mapviewer deploy Logs

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log

• WriteBack Logs

<INSTALL_DIR>/logs/system/Writeback.log

• FileProcessorDaemon Logs

<INSTALL_DIR>/bin/FileProcessorDaemon.log

2. Log into the OBIEE analytics link that is pointing to the demo database.  
Dashboard should display data with no errors.
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Demo Installation Procedure 

This chapter provides instructions for installing the demo database. 

Note: Demo installation does not support ETL functionality. ETL Job control 
dashboard accesses the OWB tables and demo dump does not have OWB 
objects; hence, ETL dashboard is not supported in demo installation. 

The chapter includes the following topics: 

• Before You Install

• OUASA Database Component Installation

• OUASA Dashboard Component Installation

• After the Installation

Before You Install
Refer to article 1391459.1 on My Oracle Support for up-to-date additional information on Oracle 
Utilities Advanced Spatial and Operational Analytics installation.

OUASA Database Component Installation
This section describes how to install demo component of Oracle Utilities Advanced Spatial and 
Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Database Creation and Dump File Import

• Security Configuration

• Spatial Configuration

Copying and Decompressing Install Media
To copy and decompress the install media, follow these steps:

1. Download the Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Oracle 
Database part from Oracle Software Delivery Cloud.

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.
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3. Copy the file OUASA-V2.4.0-Database-Multiplatform.zip from the delivered package to the 
<TEMPDIR>.

4. Unzip the zip file using any zip utility.

Database Creation and Dump File Import
Ensure that Oracle Database Server Enterprise Edition 11.2.0.2 is already installed on machine in 
order to create database.

The database creation tool (cdxdba.plx for UNIX or CDXDBA.exe for Windows) can be used for 
creating the demo database with AL32UTF8 character set.

Note: The UNIX and Windows database creation utilities will create an empty 
database with AL32UTF8 character set and at least one tablespace for storing 
the application objects before running the installation. The default name of the 
application tablespace is CISTS_01. 

UNIX Database Creation Utility
The files are located in BI240/DatabaseCreation/Unix to create the database.

1. FTP the contents of the Database Creation folder to a temporary directory on the UNIX 
server.

2. To create the database, set the ORACLE_HOME and the ORACLE_BASE variables.

3. Execute the utility cdxdba.plx by executing the following command:

perl cdxdba.plx

4. Provide the following parameter values when the script prompts:

Instance name (DEMO): DEMO

ORACLE_BASE: the directory where the setup files for the database will be created (/
orasw/app/oracle):

ORACLE_HOME: the folder where the current version of Oracle software is installed 
(/orasw/app/oracle/product/):

ORACLE_DATA: the directory where the data files for the database will be created (/
db05/oradata):

Character set for the database (AL32UTF8):

5. Enter the values based on the settings of your database server. You can also accept the default 
values displayed if they match your database server settings. You will be prompted to confirm 
the settings and select Y or N to create the database.

ORACLE_SID: DEMO

ORACLE_HOME: /orasw/app/oracle/product/

ORACLE_BASE: /orasw/app/oracle

ORACLE_DATA: /db05/oradata

Character Set: AL32UTF8

Do you want to continue (Y/N)?

6. When the database has been created, you will be prompted with the following questions:

Do you want to import a demo database dump into this database (Y/N)?

Select Y to import the Demo Install data.

For the demo installation use the dump file exp_demo.dmp.
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Do you want to import a demo database dump into this database (Y/N)? Y

Enter the name of the dump file (exp_demo.dmp):

Enter the name of the dump file directory (data_pump_dir):

Enter the name of the log file (exp_demo.log):

Note: The data_pump_dir must exist in the database created above before 
continuing with the import. You should also copy the exp_demo.dmp file to 
the data_pump_dir. Uncompress the exp_demo.dmp.gz file first to extract the 
exp_demo.dmp file. This file is in ..\BI240\Demo directory.

Set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED in the database.

Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

Update the oratab  file for the new database and then check the connectivity to 
this database from another server and from your desktop after updating local 
tnsnames.ora file.

Demo data can also be imported by using below command after successful 
database creation.

Set the correct ORACLE_SID and ORACLE_HOME first and then run 
below command to import demo dump.

impdp directory= data_pump_dir dumpfile= exp_demo.dmp logfile= 
exp_demo.log  schemas=DWADM.

Windows Database Creation Utility
The files are located in ..\BI240\DatabaseCreation\Windows. You should be logged in as a user 
who is a member of local ORA_DBA group on that server. The ORA_DBA group should have 
"administrator" privileges assigned to it.

1. To create a database, run the utility CDXDBA.exe located in the Windows folder from 
command prompt. The utility displays the following options:

E - Export a schema from the database

R - Refresh a schema with a database dump

C - Create/Recreate a local database

H - See help for the command line options

Q - Quit

2. Select option C to create an empty database on your machine and provide below inputs.

• Provide the instance name (DEMO) : <DB Name> e.g BIDEMO

• Enter the character set of the database (AL32UTF8) : AL32UTF8

• Enter ORACLE_BASE: the directory where the setup files for the database will be 
created (c:\oracle) :    <Oracle_Base>  e.g. C:\app\oracle

• Enter ORACLE_HOME: the folder where the current version of Oracle software is 
installed (c:\oracle\product\11.1.0.6\Db_1) :<Oracle_Home> e.g  
c:\app\oracle\db_home

• Enter ORACLE_DATA: the directory where the data files for the database will be 
created (C:\app\oracle\oradata) :<Directory where data files will be created>
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3. Once the database has been created, select the R - Refresh a schema option with a database 
dump file to load the Demo Install data.

• Select an option : R

• Enter the instance name (DEMO) : <DB name>

• Is it a LOCAL database (exists on the same machine) (Y/N) : <Please provide Y or N>

• Enter the name of the Oracle account that owns that application schema (spladm) : 
DWADM

• Enter password for DWADM (spladm) : DWADM

• Enter the character set of the database (AL32UTF8) : AL32UTF8

• Enter the name of data pump directory (DATA_PUMP_DIR) : DATA_PUMP_DIR

• Enter the name of the dump file (expDWADM.dmp) :exp_demo.dmp

• Enter the name of the log file (impDWADM.log) :exp_demo.log

The DBA user is the system, password is manager. Option R causes the utility to drop all the 
objects from the schema and import the schema from a database dump file.

For the Demo Installation, use the dump file exp_demo.dmp.

Note: The data_pump_dir must exist in the database created above before 
continuing with the import. You should also copy the exp_demo.dmp file to 
the data_pump_dir. Uncompress the exp_demo.dmp.gz file to extract the 
exp_demo.dmp file. This file is in the ..\BI240\Demo directory.

Set the query_rewrite_enabled parameter to FORCE and the 
query_rewrite_integrity parameter to TRUSTED in database.

Connect to sys user and execute the following commands:

alter system set query_rewrite_enabled=force;

alter system set query_rewrite_integrity=trusted;

Check the connectivity to this database from another server and from your 
desktop after updating local tnsnames.ora file

Security Configuration
For Security Configuration, perform the following steps: 

1. Navigate to the ..\BI240\DWADM\Security folder.

2. Edit the file OraGenSec.bat, which is in the same location, and replace the parameter 
database-name with the name of your database. This file is provided for your convenience 
and executes the Oragensec.exe utility based on the parameters passed into it.

Note: Ensure to run OraGenSec.bat from a Window 32-bit desktop that has 
the Oracle 11.2.0.2 client installed Your database should already be listed in the 
local file tnsnames.ora.

The script will execute as the following:

oragensec -d DWADM,DWADM,database_name -r DW_READ,DW_USER -
a A -u

DWUSER,DWREAD

3. Execute the edited OraGenSec.bat file from command prompt.
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Spatial Configuration
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Advanced Spatial and Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1240/
Spatial-Metadata folder to that location.

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=

imp_user_sdo.log schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1240/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.
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OUASA Dashboard Component Installation
This section describes how to install the dashboard component of Oracle Utilities Advanced 
Spatial and Operational Analytics. The section includes the following:

• Copying and Decompressing Install Media

• Setting Permissions for cistab File in UNIX

• OUASA Dashboard Package Installation Steps

• Post-installation Tasks

Copying and Decompressing Install Media
The Oracle Utilities Advanced Spatial and Operational Analytics application server installation file 
is delivered in jar format for both UNIX and Windows platforms. If you plan to install multiple 
Oracle Utilities Advanced Spatial and Operational Analytics environments operated by different 
Oracle Utilities Administrator user IDs, you must complete each of the following installation steps 
for each Administrator user ID.

1. Login to the application server host (where OBIEE 11.1.1.5.0 software is installed) as the 
Oracle Utilities Advanced Spatial and Operational Analytics administrator user ID (default 
ceases).

2. Create a temporary directory, such as c:\OUASA\temp or /OUASA/temp. (Referred to 
below as <TEMPDIR>.) This directory must be located outside any current working Oracle 
Utilities application environment. All files that are placed in this directory as a part of the 
installation can be deleted after completing a successful installation.

3. Copy the file OUASA.V2.4.0-MultiPlatform.jar from the delivered package to the 
<TEMPDIR>. If you are using FTP to transfer this file, remember to use the BINARY 
option for the FTP transfer.

4. Decompress the file:

cd <TEMPDIR>

jar -xvf OUASA.V2.4.0-MultiPlatform.jar

Note: You must have Java JDK installed on the machine used to (un)jar the 
application server installation package. Install the JDK that is supported for the 
install on your platform to be able to use the jar command.

The Java packages are located at: http://java.sun.com/products/archive/index.html

A sub-directory named "OUBI.V2.4.0" is created. It contains the installation software for the 
Oracle Utilities Business Intelligence application server.

Setting Permissions for cistab File in UNIX
Every Oracle Utilities Advanced Spatial and Operational Analytics environment installed on a 
server must be registered in the /etc/cistab file located on that server. On UNIX servers, generally 
only the root user ID has write permissions to the /etc directory. Since the installation process is 
run by the Oracle administrator user ID (cissys), this user ID may not be able to write to /etc/
cistab table.

The install utility checks permissions and if it identifies a lack of the necessary permissions, it 
generates a script in the <TEMPDIR>/OUBI.V2.4.0 directory named 
cistab_<SPLENVIRON>.sh. Run the generated script using the root account before continuing 
with the installation process. The script initializes the cistab file in /etc directory (if it is the first 
Oracle Utilities Advanced Spatial and Operational Analytics application environment on the 
server) and registers a new environment.
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The generated script also changes the owner of /etc/cistab file to the Oracle Utilities Advanced 
Spatial and Operational Analytics administrator user ID, so that the next time a new environment 
is created by the same Oracle Utilities Advanced Spatial and Operational Analytics administrator 
user ID, you do not need to run the generated script with the root user ID. Instead, the install 
utility itself proceeds with the registration.

If you are reinstalling an existing environment, only the validation of /etc/cistab entry is done by 
the install utility, no new registration occurs. The install utility interactively instructs you about 
every step that needs to occur in each specific case.

If you plan to upgrade an existing environment it is your responsibility to take a backup prior to 
the installation process. The installation utility does not create a backup of existing environment.

OUASA Dashboard Package Installation Steps
Before you install verify that the steps mentioned in Prerequisite Software for OUASA 
Dashboard Component are followed. 

To install the OUASA dashboard package, perform these steps. 

1. Change to the <TEMPDIR>/OUBI.V2.4.0 directory.

2. Set the ORACLE_CLIENT_HOME and PATH variables as Oracle Client Perl is required to 
run the installer.

3. Execute the following script:

For UNIX:

export ORACLE_CLIENT_HOME=<oracle_client_home>

export PERL_HOME=$ORACLE_CLIENT_HOME/perl

export PATH=$PATH:$PERL_HOME/bin

ksh ./install_OUBI.sh

For Windows:

set ORACLE_CLIENT_HOME=<oracle_client_home>

set PERL_HOME=%ORACLE_CLIENT_HOME%\perl

set PATH=%PERL_HOME%\bin;%PATH%

Install_OUBI.cmd

Note: On UNIX, ensure that you have the proper execute permission on 
install.sh.

4. The Oracle Utilities Advanced Spatial and Operational Analytics specific menu appears.

5. Under the Installation Options, enter “OBIEE”.

6. Select the Each Menu Item to configure the values. For detailed description of the values 
see Configuration Worksheet for ETL Component Installation.

************************************

* Environment Installation Options *

************************************

1.

       Oracle Client Home Directory:                      

       Installation Options:                              
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2.

       Environment Mount Point:                           

       Log Files Mount Point:                             

       Environment Name:                                  

       Web Java Home Directory:                           

       Database Home Directory:                           

       Database Type:                                     oracle

Each item in the above list should be configured for a successful install.

Choose option (1,2, <P> Process, <X> Exit):

7. In the below Environment Configuration worksheet, only 1 and 2 menu items are required to 
be configured. For detailed description of these values, see Configuration Worksheet for 
ETL Component Installation.

*****************************

* Environment Configuration *

*****************************

1. Environment Description

       Environment Description:

2. OBIEE Environment Configuration

       Oracle BI Instance Home:

       Oracle BI Home:

       Oracle BI Domain Home:

       Weblogic Domain Console User Name:

       Weblogic Domain Console Host:

       Weblogic Domain Console Port Number:

3. Database Configuration

4. DESIGN REPOSITORY CONFIGURATION

5. DATABASE CHARACTER SET CONFIGURATION

6. EDITING PROCESS FLOW CONFIGURATION

7. EMAIL CONFIGURATION

8. CONTROL CENTRE CONFIGURATION

9. EXTERNAL DATA SOURCE CONFIGURATION

       Path of the External Datasource LOG:

Each item in the above list should be configured for a successful install.

Choose option (1,2,3,4,5,6,7,8,9, <P> Process, <X> Exit):
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8. When you are done with the parameter setup, proceed with the option P. Write the Configure 
file.

9. Once the install has finished successfully, you will need to execute post-installation steps as 
described in Post-installation Tasks.

Post-installation Tasks
Following topics are discussed in this section: 

• Deploying Repository (RPD) File

• Configuring and Deploying MapViewer

• Deploying Write Back

• Deploying Analytics

Deploying Repository (RPD) File
The RPD file is located at: <install_dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd, where 
<install_dir> is the OUASA dashboard package installation directory.

To deploy the RPD file, perform these steps:

1. OBIEE 11.1.1.5.0 should have been installed on Windows 32-bit machine before proceeding 
with the steps below.

2. Launch the Administration Tool from your Start menu from the Windows machine. This is 
only available in Windows.

Start > Programs > Oracle Business Intelligence > Administration.

3. Open the RPD in offline mode by selecting File > Open > Offline...

4. Provide the RPD password. For example, “oracle123”.
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5. Edit the connection pools shown below by double clicking on them.

6. In the Init Block Connection Pool group, enter the following:

Datasource name = BI Database name

User name = DWREAD

Password = DWREAD User password

7. In the Init Block Pool - MDM group, provide the following, only for MDM:

Datasource name = MDM database name

User name = CISUSER

Password = CISUSER User password

8. In the MDM Database Connection group, provide the following, only for MDM:

Data source name = MDM database name

User name = CISUSER

Password = CISUSER User password

9. In the ODIDEV Connection Pool group, provide the following:

Data source name = BI database name

User name = DWUSER

Password = DWUSER User password

10. In the OUBI Database Connection group, provide the following:

Data source name = BI database name

User name = DWREAD
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Password = DWREAD User password

11. Click Save.

12. Login into OBIEE Enterprise Manager.

13. Navigate to BI Instance >Coreapplication>Deployment.

14. Lock and edit.

The repository text box will be enabled.

15. Browse to the modified rpd file and submit. The file is in the following location, where 
<install_dir> is the OUASA dashboard package installation directory.

<Install_Dir>/Reports/rpd/UtilitiesBusinessAnalytics240.rpd

16. Provide the RPD password “oracle123” click Apply.

17. Activate the changes and then restart the BI Services.

Note: All the above databases set in the connection pool should be updated in 
tnsnames.ora file in <OBIEE_INSTALL_DIR>/Oracle_BI1/network/
admin.

Deploying the Web Catalog
Note: You must delete the old BI v2.3.2.1 catalogs (if present in 11g OBIEE 
instance) before deploying the catalogs.

To delete the old catalogs, follow these steps:

1. Launch the Catalog Manager from your Start menu.

Start > Programs > Oracle Business Intelligence > Catalog Manager

2. From the File menu, select Open Catalog. The Open Catalog window is displayed.
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3. Specify the following values:

1. From the Type drop-down, select Online.

2. Enter the URL to the analytics Web application in the following form:

http://<OBIEE Host>: <OBIEE Port>/analytics/saw.dll

3. Enter Administrator as the User and ASAadm as the Password.

4. Click OK to close the window.

5. In the tree panel, expand the root folder /.

6. Select the Shared folder.

7. Select the catalogs in the shared folder, right click, and select Delete.

It will prompt for Physical Catalog location configured in Enterprise Manager. This is the server 
path where OBIEE is installed.

To deploy the catalogs, follow these steps:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin
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ksh ./deploycatalog.sh

Enter the physical catalogs location configured in Enterprise Manager. For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd  %SPLEBASE%\bin

deploycatalog.cmd

Enter the Physical Catalogs location configured in EM For example:

<OBIEE_INSTALL_DIR>/instances/instance1/bifoundation/
OracleBIPresentationServicesComponent/coreapplication_obips1/catalog/
SampleAppLite

Configuring and Deploying MapViewer
To configure and deploy the MapViewer, perform the following steps: 

1. Login to WebLogic console.

2. In the WebLogic console, create the 'MAP_DS' data source.

3. Lock and edit.

4. Navigate to Services < Data Sources.

5. Select New > Generic Data Source and provide the following:

Name = MAP_DS

JNDI Name = MAP_DS

Database Type = oracle

6. Click Next.

7. Enter the following:

Database Driver = XA thin database driver

8. Click Next.

9. Enter the following Connection properties:

Database Name:BI Database Name

Host Name:Database host

Port:Database port

Database User Name:dwadm

Password:dwadm password

10. Click Next and then click Finish.

11. Click Activate Changes.

12. Update the mapViewerConfig file with below mentioned tags:

File location : <OBIEE_INSTALL_DIR>/Oracle_BI1/bifoundation/jee/
mapviewer.ear/web.war/WEB-INF/conf/
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File: mapViewerConfig.xml

13. If there is proxy used, insert the list of host names for all the third party service providers in 
the security_config node.

<proxy_enabled_hosts>

elocation.oracle.com,maps.weatherbug.com,direct.weatherbug.com,api.wxbug.net,de.tiles.wea
therbug.com

</proxy_enabled_hosts>

14. Update the following ns_data_provider node:

<ns_data_providerid="obieeNsdp"

class="com.oracle.utilities.birdseye.BirdseyeNSDP" />

15. Update the current map_tile_server with the following map_tile_server node.

<map_tile_server>

<tile_storage default_root_path="/mytilecache/"/>

</map_tile_server>

16. Update the instance config file location, for example:

FileLocation:

For Unix :

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

For Windows:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips1

Modify instanceconfig.xml - Update the security Node with the following values. If the 
security Node is not present, add following code before </Serverinstance>:

<Security>
<ClientSessionExpireMinutes>210</ClientSessionExpireMinutes>
<HttpOnlyCookies>false</HttpOnlyCookies>
<CookieDomain />
<CookiePath>/</CookiePath>
</Security>

Deploying Custom MapViewer - To deploy the custom MapViewer, follow these steps:

For Unix:

cd $SPLEBASE/bin

ksh ./deploymapviewer.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

cd %SPLEBASE%\bin

deploymapviewer.cmd

Enter WebLogic Domain Console Password. For example, weblogic123
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Perform the following steps after deploying the custom MapViewer:

1. Update the MapViewer configuration by navigating to MapViewer > Administration > 
Configuration.

2. Add the below content in the mapViewerConfig.xml with appropriate values:

<DB_HOST>,<DBNAME>,<DB_PORT>,<USER>,<PASSWORD>

<map_data_source name="MAPCONN"

jdbc_host="<DB_HOST>"

jdbc_sid="<BI Database Name>"

jdbc_port="<DB_PORT>"

jdbc_user="<DWADM>"

jdbc_password="<!DWADM PASSWORD>"

jdbc_mode="thin"

number_of_mappers="32"

allow_jdbc_theme_based_foi="true"

/>

3. Save and then restart.

Note: The above step has to be performed each time after running the 
deploymapviewer command.

Deploying Write Back
Follow these steps to deploy the write back feature.

1. Open the following file:

<OBIEE_INSTALL_DIR>\instances\instance1\config\OracleBIPresentationServicesCo
mponent\coreapplication_obips\instanceconfig.xml

2. Update the following <ServerInstance> element according to the following code:

<LightWriteback>true</LightWriteback>

3. Deploy write back as follows:

For UNIX:

Initialize the environment with the ./splenviron.sh -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd $SPLEBASE/bin

ksh ./deploywriteback.sh

For Windows:

Initialize the environment with the ./splenviron.cmd -e <envname> command.

Note: Navigate to the Install_Dir/bin to initialize.

cd %SPLEBASE%/bin

deploywriteback.cmd
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Deploying Analytics
To deploy analytics, follow these steps:

1. Edit the Presentation Services configuration file, "instanceconfig.xml", in the following 
directory:

<OBIEE_INSTALL_DIR>/instances/instance1/config/
OracleBIPresentationServicesComponent/coreapplication_obips1

2. Add the following before the end tag </ServerInstance>

<UI>

<DefaultStyle>oubi</DefaultStyle>

<DefaultSkin>oubi</DefaultSkin>

</UI>

Enabling Analytics Help
To enable the analytics' help, follow these steps:

1. Download Oracle Utilities Advanced Spatial and Operational Analytics User Guide from Oracle 
Software Delivery Cloud.

2. After downloading the OUASA User Guide, change the name of the Help file to OUASA 
Help.pdf.  
Now, place the Help file in <install_dir>/Skin/res, where <install_dir> is the OUASA 
dashboard package installation directory.

3. Run the following commands:

For UNIX:

cd $SPLEBASE/bin

ksh ./deployanalyticsear.sh

Enter the WebLogic Domain Console Password. For example, weblogic123

For Windows:

cd %SPLEBASE%/bin

deployanalyticsear.cmd

Enter the WebLogic Domain Console Password. For example, weblogic123

4. Restart the BI Core services.

5. Restart WebLogic and all BI services after the OBIEE deployment is completed.

6. Login to Analytics and navigate to Administration > Manage Privileges > Write Back > 
Write Back to Database.

7. Click Denied:Authenticated User and select the permission Granted.

After the Installation 
After the installation, perform the following: 

1. Verify Install and Deploy Logs.

Custom Mapviewer deploy logs

<INSTALL_DIR>/logs/system/mapviewerdeploy.sh.log
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WriteBack logs

<INSTALL_DIR>/logs/system/Writeback.log

2. Log into OBIEE analytics link that is pointing to demo database. Dashboard should display 
the data with no errors.
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Chapter 10 
Configuring Your Applications

This chapter provides instructions for configuring additional applications for use with Oracle 
Utilities Advanced Spatial and Operational Analytics. It contains the following topics:

• Spatial Configuration

• OBIEE Configuration

Spatial Configuration
This section contains information related to configuring Oracle Utilities Advanced Spatial Outage 
Analytics and how to set up the spatial data and its corresponding metadata. The mapping 
between the spatial columns and the dimensional columns like State from Address dimension 
would be defined in map meta data that is available as a part of the WebCatalog. Using the spatial 
data and the map meta data, users can view the transactional data on the map view.

As an example, steps to setup the data for United States (US) are mentioned below: 

• Installing US State Spatial Data

• Installing US City Spatial Data

• Installing US Zip Code Spatial Data

• Installing US County Spatial Data

• Configuring NMS Device Spatial Data

• Loading Spatial Metadata

• Improving Performance by Prefetching Map Tiles

Installing US State Spatial Data
Spatial data can be loaded from various sources. One of the approaches is to use the world sample 
data given by Navteq. There is a pointer to the data set from the Oracle Spatial OTN page for 
downloading Partner data:

http://www.oracle.com/technology/products/spatial/htdocs/spatial_partners_data.html

There are various versions of the world sample dataset. These instructions assume that you are 
using the version with a world_sample2010.dmp file. If you have a different version, then these 
instructions may not work and you should refer to the README included in the downloaded 
world_sample.zip file.

These instructions also assume that the sample data will be loaded into the DWADM account, 
used for the Data Warehouse. If you want to follow the instructions in the world sample 
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README file instead, then the data will be loaded into a WORLD_SAMPLE account, and steps 
will need to be changed to use that account instead of DWADM.

Use the following procedure to install the world sample data.

1. Create a work directory on your machine for the data, and change directory to the new 
directory. For example: 

mkdir NAVTEQ 
cd NAVTEQ

2. Unzip the world_sample.zip file you downloaded to the new directory. For example: 

unzip world_sample.zip 

3. Connect to SQLPLUS using DWADM, and remove the old tables (if present). For example: 

sqlplus dwadm/dwadm@database @cln_sample_data.sql 

4. Import the world sample dump file into the DWADM account. For example: 

imp dwadm/dwadm@database file=world_sample2010.dmp 
 log=world_sample.log full=y

5. After importing the world sample dump file, create the MapViewer Spatial metadata using the 
following insert statements: 

sqlplus  dwadm/dwadm@database
INSERT INTO user_sdo_maps SELECT * FROM sdo_maps;
INSERT INTO user_sdo_themes SELECT * FROM sdo_themes;
INSERT INTO user_sdo_styles SELECT * FROM sdo_styles;
INSERT INTO user_sdo_cached_maps SELECT * FROM sdo_cached_maps;

6. Create the State spatial table and metadata are used by the default themes present in the 
OUASA metadata. This assumes that the eLocation web site is being used as the base map. If 
some other base map is used, then the transform parameter will need to specify the SRID of 
the base map being used.

sqlplus  dwadm/dwadm@database
create table q1_states54004 (

      feature_id number,
      feature_name varchar2(255),
      area_id number,
      name_langcode varchar2(35),
      feature_type varchar2(30),
      country_code_3 varchar2(5),
      geometry SDO_GEOMETRY,
      carto_id number(10,0));

insert into q1_states54004
select null, name, null, lang_code, feature_type,

       ISO_COUNTRY_CODE, sdo_cs.transform(geometry, 54004), 
       carto_id

FROM wom_area
WHERE feature_type = 909996

  and iso_country_code = 'USA';

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_STATES54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);
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create index q1_STATES54004_sdx 
    on q1_STATES54004(geometry) 
    indextype is mdsys.spatial_index;

Installing US City Spatial Data
US City shape data is available in the world sample data set, however, only the three hundred 
largest cities are available there. To find additional sample data for each US State from the US 
Census Bureau, visit:

http://www.census.gov/geo/www/cob/pl2000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load city data for other US states.

1. Click the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to the 
NAVTEQ directory created in the previous procedure. 

2. Unzip or decompress the pl39_d00_shp.zip file to the NAVTEQ directory. 

3. Download standalone MapBuilder from this location:  
http://www.oracle.com/technetwork/middleware/mapviewer/downloads/index-
100641.html 

4. Start MapBuilder. This is installed when MapViewer is installed. On windows it can be started 
by running:  
java -jar mapbuilder.jar 
Refer to the MapViewer documentation for instructions on installing and running 
MapBuilder from this location: 
   http://www.oracle.com/technetwork/middleware/mapviewer/documentation/index.html  

5. If a connection is not created, then select File -> New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

6. Select Tools -> Import Shapefile, and click Next. 

7. Click Shapefile. 

8. Browse to the C:\NAVTEQ directory, select the pl39_d00_shp.shp file, and click Open. 

9. Click Next. 

Ensure that the name of the geometry table is set to pl39_d00. If this is not the 
desired name for the spatial table, then the select statement below will need to 
be changed to use the entered name. 

10. Ensure the Create Predefined Theme box is unchecked, and click Next. 

11. Review the Summary information and click Finish. 
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12. Create the Q1_CITY54004 table using the following SQL statement. This assumes that the 
eLocation web site is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database
create table Q1_CITY54004 as
select upper(name) FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
       'OHIO' state

From pl39_d00
Where lsad_trans in ( 'city', 'village' );

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_CITY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index Q1_CITY54004_sdx 
    on Q1_CITY54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_city54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Installing US Zip Code Spatial Data
Sample shape files for US Zip Code Areas can be found at the following location:

http://www.census.gov/geo/www/cob/z52000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load zip code data for other US states.

1. Click on the Ohio Zip Code in Shapefile format and download the zt39_d00_shp.zip file to 
the NAVTEQ directory created in the previous procedure. 

2. Unzip the zt39_d00_shp.zip file to the NAVTEQ directory. 

3. Start MapBuilder. This is installed when MapViewer is installed. Refer to the MapViewer 
documentation for instructions on installing and running MapBuilder.
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4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

5. Select Tools > Import Shapefile and click Next. 

6. Click Shapefile. 

7. Navigate to the C:\NAVTEQ directory, select the zt39_d00.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to ZT39_D00. If this is not 
the desired name for the spatial table, then the select statement below will need 
to be changed to use the entered name.  

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the Summary information and click Finish. 

11. Create the Q1_USZIP54004 table using the following SQL statement. This assumes that the 
eLocation web site is being used as the base map.  If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_USZIP54004 as

select zcta ZCTA5CE,
       sdo_cs.transform(geometry, 54004) geom

From ZT39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_USZIP54004','GEOM',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_USZIP54004_sdx 
    on q1_USZIP54004 (geom) 
    indextype is mdsys.spatial_index;

UPDATE q1_uszip54004
  SET geom = SDO_UTIL.RECTIFY_GEOMETRY(geom, .05);
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Installing US County Spatial Data
Sample shape files for US Counties can be found at the following location:

 http://www.census.gov/geo/www/cob/co2000.html

The following steps can be used to load the sample data for the state of Ohio, and similar steps 
can be followed to load county data for other US states.

1. Click on the Ohio County in Shapefile format and download the co39_d00_shp.zip file to the 
NAVTEQ directory created in the previous procedure. 

2. Unzip the co39_d00_shp.zip file to the NAVTEQ directory. 

3. Start MapBuilder. This is installed when MapViewer is installed. Refer to MapViewer 
documentation for instructions on installing and running MapBuilder.

4. If a connection is not created, then select File > New Connection, and create a connection 
to the DWADM account in the OUBI Data Warehouse Database. 

5. Select Tools > Import Shapefile, and click Next. 

6. Click Shapefile. 

7. Browse to the C:\NAVTEQ directory, select the co39_d00_shp.shp file, and click Open. 

8. Click Next. 

Note: Ensure the name of the geometry table is set to CO39_D00. If this is 
not the desired name for the spatial table, then the select statement below will 
need to be changed to use the entered name.

9. Ensure the Create Predefined Theme box is unchecked, and click Next. 

10. Review the Summary information and click Finish. 

11. Create the Q1_COUNTY54004 table using the following SQL statement. This assumes that 
the eLocation web site is being used as the base map. If some other base map is used, then the 
transform parameter will need to specify the SRID of the base map being used.

sqlplus  dwadm/dwadm@database

create table q1_COUNTY54004 as
select name FEATURE_NAME,

       sdo_cs.transform(geometry, 54004) geometry,
Configuring Your Applications 10-6 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Spatial Configuration
       'OHIO' state
From CO39_D00;

INSERT INTO user_sdo_geom_metadata
VALUES ( 'Q1_COUNTY54004','GEOMETRY',
MDSYS.SDO_DIM_ARRAY(MDSYS.SDO_DIM_ELEMENT('X',- 
20500000,20500000,0.0005),MDSYS.SDO_DIM_ELEMENT('X',- 
50000000,19000000,0.0005)), 54004);

create index q1_COUNTY54004_sdx 
    on q1_county54004 (geometry) 
    indextype is mdsys.spatial_index;

UPDATE q1_county54004
  SET geometry = SDO_UTIL.RECTIFY_GEOMETRY(geometry, .05);

Note: No predefined reports make use of the County data, so if county spatial 
reports are desired, the Q1_COUNTY_54004 theme will need to be used in 
new requests and maps.

Configuring NMS Device Spatial Data
To implement the NMS Network Model on the spatial analytics, OUASA reports need NMS 
geometry data. The steps from this section are required to view data in spatial reports of Outage 
Analytics. There are several ways that the geometry data in the DIAGRAM_OBJECTS NMS 
device table can be accessed by the OUASA Mapping reports. 

This section describes the following methods:

• Replicating the DIAGRAM_OBJECTS Table

• Accessing the NMS Spatial Data Using a Database Link

Replicating the DIAGRAM_OBJECTS Table
The easiest option is to replicate the DIAGRAM_OBJECTS table into the OUASA database. If 
this is done, then after replicating the DIAGRAM_OBJECTS table, the following steps will setup 
the OUASA dashboards to use the data in this replicated table.

1. Create the required Spatial Metadata:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
        SDO_DIM_ELEMENT('X', -20037508, 20037508, .05),
        SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)
), 54004);

2. Ensure that the spatial index is created on the LL_GEOMETRY column. The 
LL_GEOMETRY column by default stores spatial data using SRID 54004, so this will work 
without changes with the eLocation base map:

create index q1_DIAGRAM_OBJECTS_sdx 
    on diagram_objects (ll_geometry) 
    indextype is mdsys.spatial_index;

3. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
Geometry Theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUASA Database
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• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Once DIAGRAM_OBJECTS table is replicated to the OUASA database, follow the below steps 
to create Q1_DIAGRAM_OBJECTS_54004 table:

1. Connect to DWADM schema of OUASA database and execute "create table 
Q1_DIAGRAM_OBJECTS_54004 as select * from DIAGRAM_OBJECTS;"

2. INSERT INTO user_sdo_geom_metadata 
VALUES ( 'Q1_DIAGRAM_OBJECTS_54004','LL_GEOMETRY', 
MDSYS.SDO_DIM_ARRAY(SDO_DIM_ELEMENT('X', -20037508, 20037508, 
.05),SDO_DIM_ELEMENT('Y', -45884542, 45884542, .05)), 54004);

3. Create index q1_DIAGRAM_OBJECTS_sdx_54004 on Q1_DIAGRAM_OBJECTS_54004 
(ll_geometry) indextype is mdsys.spatial_index;

Accessing the NMS Spatial Data Using a Database Link
If it is not possible to replicate the DIAGRAM_OBJECTS table, and no existing NMS Geometry 
theme can be used, then it is possible to access the DIAGRAM_OBJECTS table in the OUASA 
database using a database link. 

To access the DIAGRAM_OBJECTS table in the OUASA database using a database link:

1. Create a database link in the OUASA database pointing to the NMS database.

2. Create a synonym DIAGRAM_OBJECTS for the DIAGRAM_OBJECTS table in the NMS 
database.

3. Update the mapViewerConfig.xml to add another datasource, pointing to the NMS database, 
just like the OUASA datasource was added earlier in the install documentation

4. Restart WebLogic to make the NMS database available.

5. Create the required Spatial Metadata in the OUASA database:

INSERT INTO user_sdo_geom_metadata 
VALUES ( 'DIAGRAM_OBJECTS','LL_GEOMETRY',

MDSYS.SDO_DIM_ARRAY(
   MDSYS.SDO_DIM_ELEMENT('LONGITUDE',-180,180,0.05),
   MDSYS.SDO_DIM_ELEMENT('LATITUDE',-90,90,0.05)
), 54004);

6. In MapBuilder, use duplicate to create a copy of the B1_THEME_DIAGRAMOBJ_54004 
Geometry Theme, with the following settings:

• New Name: Q1_THEME_DIAGRAMOBJ_54004

• Target Database: OUASA Database

• Base Table: DIAGRAM_OBJECTS

• Spatial Column: LL_GEOMETRY

Loading Spatial Metadata
This section describes how to load spatial metadata in USER_SDO* tables for Oracle Utilities 
Oracle Utilities Advanced Spatial Operational Analytics. 

Use the following procedure to load spatial metadata in the target database.

1. Create the dump_dir directory in database and copy user_sdo.dmp file from ../B1240/
Spatial-Metadata folder to that location. 

2. Import released spatial tables to the target database using following command:

impdp directory=dump_dir dumpfile=user_sdo.dmp logfile=  
Configuring Your Applications 10-8 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Spatial Configuration
    imp_user_sdo.log  schemas=DWADM

Note: Run this command from database server.

3. Review the imp_user_sdo.log file to ensure the tables were imported successfully.

4. After importing the tables, run following SQL scripts from the ../B1240/Spatial-Metadata 
folder:

- sqlplus dwadm/dwadm@database-name @copy_spatial_metadata.sql

- sqlplus dwadm/dwadm@database-name @clean_sdo_release_tbls.sql

5. Review the log files.

Flushing Map Cache
Before you can begin using the modified base map, you must flush the map cache as follows:

1. In the MapViewer Console, click Admin in the top-right corner of the page and log in to the 
Admin Console page.

2. Click Management, select Manage MapViewer, and then select Datasources.

3. Click Purge cached metadata.

4. To verify the map changes, go to the Map zone that references the modified base map.

5.  Delete the 'cacheduserinfo' files in the following path to remove any cache:

<OBIEE_INSTALL_DIR>\instances\instance2\bifoundation\OracleBIPresentationServi
cesComponent\coreapplication_obips1\catalog\SampleAppLite\root\users\weblogic2
\_prefs

Improving Performance by Prefetching Map Tiles 
Rendering map tiles dynamically can affect system performance. To avoid this you should 
consider prefetching tiles by issuing an admin request to MapViewer on a non-production 
server or when the server is not under load. When MapViewer receives a prefetching request, 
it issues many concurrent map tile requests to itself, which are basically XML map requests, 
and stores them in the cache. This improves the system’s performance as the images are 
readily available.

Follow the following procedure to prefetch map tiles.

1. In the MapViewer Console, click Admin in the top-right corner of the page and log in to the 
Admin Console page.

2. In the Admin Console page, click Manage Map Tile Layers.

3. Click Manage to display the list of existing map tiles.

4. Select the required map tile and click View map/Manage Tiles.
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The Prefetching wizard opens:

5. Enter the X, Y coordinates of the center of the map, and the SRID and Zoom Level, and 
click Show Map. 

To prefetch map images, you need to enter the latitude and longitude values. A client needs to 
know the latitude and longitude values of the center of the location in interest. SRID is a 
unique value used to identify the coordinate system used in a GIS application. The SRID used 
is 8307. 

The X and Y axis used in the following example is for Canton, Ohio:

6. When you see the map, turn on the Area Selection Tool and select the area on the map for 
which you want to prefetch the tiles.

7. Select one or more zoom-levels for which you want to prefetch the tiles.

8. Under Tile Operations, click on Prefetch Tiles.

This process will take some time, depending upon the hardware configuration of the system and 
the amount of data to be prefetched. To check the current status of the operation, click Refresh 
under Operation Status. The status will change to “Finished” when the operation is done.

OBIEE Configuration
This section contains information about configuring Oracle Business Intelligence Enterprise 
Edition (OBIEE) for use with Oracle Utilities Advance Spatial and Operational Analytics. 
Following topics are discussed: 

• Setting Up and Configuring User Security

• Managing Content in the Presentation Catalog

Setting Up and Configuring User Security
Refer to the Configuring User Security section in the Oracle Utilities Advanced Spatial and Operational 
Analytics Administrator's Guide for details on configuring user security.
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Managing Content in the Presentation Catalog
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 Presentation Catalog has a 
different folder for each of the analytics.

The following folders are available on the Shared Folders:

• About

• Administration

• Common

• Credit & Collections Analytics

• Customer analytics

• Distribution Analytics

• Meter Data Analytics

• Mobile Workforce Analytics

• Outage Analytics

• Revenue Analytics

• Shared Objects

• Work & Asset Analytics

For more information on User Security and Managing Catalog objects, refer to the Oracle Business 
Intelligence Presentation Services Administration Guide.

Managing Folders and Content 
New folders can be created by the customer if new Answers or modifications to existing ones are 
needed.

To create new folders (or Development Folders), log on to the Presentation Services as an 
Administrator and access:

Catalog -> New Folder

Once a new folder is created, the following values can be set:

• Properties

• Name 

• Delete

• Permissions

• Copy/Move

The customer can save new Answers onto the development folders, thereby leaving the out-ofbox 
folders as is. Once the Answer is created, the report is written and unit testing is complete, the 
request can be moved to the common folder.

Default folders are loaded during the install of OBIEE. These folder, such as 00 Overview, 01 
Ranks & Toppers, or 02 History & Benching, can be removed from view by navigating to Catalog, 
and then deleting the dashboards that you do not want displayed from the list.

Editing Names and Descriptions of Objects 
To edit names and descriptions of objects, log on to the Presentation Services as an Administrator 
and access:

Catalog > Shared Folders
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Chapter 11
Installing Optional Software

This chapter describes the optional software that can be installed with Oracle Utilities Advanced 
Spatial and Operational Analytics. Following is discussed here: 

• Oracle Utilities Business Intelligence

Oracle Utilities Business Intelligence
For information on installing Oracle Utilities Business Intelligence v2.4.0, see the Oracle Utilities 
Business Intelligence Installation Guide and Oracle Utilities Business Intelligence DBA Guide that are 
included in the Oracle Utilities Advanced Spatial and Operational Analytics Media Pack.



Additional Information for Installing Other Oracle Software 12-1 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide

Chapter 12 
Additional Information for Installing Other 

Oracle Software

This chapter provides information about installing other Oracle software while installing Oracle 
Utilities Advanced Spatial and Operational Analytics.

The chapter includes:

• Oracle Warehouse Builder 11.2.0.2

• Oracle Business Intelligence Enterprise Edition 11.1.1.5.0

Oracle Warehouse Builder 11.2.0.2
Oracle Warehouse Builder 11.2.0.2 is pre-installed with Oracle Database 11.2.0.2 and hence is not 
required to be installed separately.

Oracle Business Intelligence Enterprise Edition 11.1.1.5.0
Oracle Utilities Advanced Spatial and Operational Analytics v2.4.0 is supported with Oracle 
Business Intelligence Suite Enterprise Edition Version 11.1.1.5.0.

Refer the Oracle Business Intelligence Suite Enterprise Edition Documentation Library for 
installation instructions.



Appendix A
Data Warehouse Implementation Guidelines

This chapter provides guidelines for implementing the data warehouse setup for Oracle Utilities 
Advanced Spatial and Operational Analytics. 

The following sections are discussed in detail:

• Init.ora Settings

• Oracle Partitioning

Init.ora Settings
Internal performance testing for a large Business Intelligence (BI) database installation has 
identified the following parameter settings that resulted in a fast load and materialized view refresh 
for a fact table with over 100,000,000 records.

Note that the settings mentioned in the below table were noticed for an Oracle 10.2 database 
running on an IBM AIX 5.2 machine with 8 CPUs and 15 GB of memory; hence, some of these 
values may not apply for different hardware or software settings.

Parameter Value

db_file_multiblock_read_count 32

db_cache_size 0M

shared_pool_size 0M

large_pool_size 0M

Java_pool_size 0M

parallel_max_servers 8

parallel_execution_message_size 65535

log_buffer 64554432

Pga_aggregate_target 2000M

query_rewrite_enabled FORCE

query_rewrite_integrity TRUSTED

session_cached_cursors 60

optimizer_index_caching 80
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Oracle Partitioning
As the primary keys for all tables are sequential, it is possible to partition any table based on the 
primary key field. However, the Fact tables should be partitioned based on one of the Date Keys 
present in the table. Some of the date keys are optional; hence, it is important to pick a date key 
field that will always have a non-zero value.

Note that as the RECENT fact table needs to be purged daily, it does not require to be 
partitioned. Also, partitioning should be done only when materialized views do not prove 
sufficient enough to achieve the desired performance. 

For details on partitioning, refer to the Oracle Utilities Advanced Spatial and Operational Analytics 
Admininstrator’s Guide. 

optimizer_index_cost_adj 30

Sga_max_size 4000M

Sga_target 2000M

shared_pool_reserved_size 64M

workarea_size_policy AUTO

db_writer_processes 8

timed_statistics False

cursor_space_for_time True

Disk_asynch_io True

Parameter Value
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Installation Menu Functionality

This chapter provides functionality details regarding installation menu for installing the Oracle 
Utilities Advanced Spatial and Operational Analytics application. 

The following sections are discussed here:

• Installation Menu Functionality Overview

• Installation Menu Functionality Details
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Installation Menu Functionality Overview
The main configuration menu is structured so that related variables and/or options are grouped 
together and are associated by a menu item number. To access a particular group of variables and 
options, enter the menu item number associated with that group. Each option within a group is 
displayed in turn on the screen along with a prompt so that you can type the desired value for the 
option, if it is not the same as the default or current value.

When performing the initial installation, you need to go through all menu options. The menu 
options may have a default value, a list of valid values, and a validation check.

On each option prompt, you can keep the current value by simply leaving the input line empty. In 
order to erase a variable value, you need to enter a single dot ("."). The leading spaces are trimmed 
out on each values that are entered.

Note: While working with the menu, you will notice the following:

• Valid Values: [ALFANUM]. This indicates you will need to enter an alphanumeric value 
in the prompt.

• Valid Values: [NUM]. This indicates you will need to enter an numeric value in the 
prompt.

When all the menu options are set, type <P> at the main menu prompt option. The option values 
selected throughout the configuration are saved. 

During this processing, the global variables are validated and the configuration file 
<SPLEBASE>/etc/ENVIRON.INI is created or updated. This file contains all the variables 
inputted and calculated. These are required by the next part of the installation process.

To exit the configuration utility without saving any of the values entered, type <X> and click 
Enter. 

Installation Menu Functionality Details
The Environment Installation Utility requires that Oracle Client Home is set in the path for the 
user performing the installation. Prior to running the installation utility, you must review the 
supported platforms document to ensure that you have all  the required Third-Party software 
installed at your end. In the Installation menu if the variables are set prior to execution, then these 
variable values will be defaulted by the installation utility during installation.

When installation completes successfully, the values will be written to an ENVIRON.INI file. 
When splenviron.sh / cmd is executed, it reads from the ENVIRON.INI file to set the 
environment variables.

In the worksheets, there are three different types of values given:

• Default Values are the values that will be defaulted when running the installation utility.

• Security Values denote values that should be changed when in production.

• Example Values are values that can be used for a default installation.

Note: The production environment should not be run with default values.

Refer to the Server Administration Guide for additional information about configuring these values.

When you enter passwords, you do not see the password characters on the screen as they are 
entered in silent mode. Passwords are encrypted when the values are entered by a user.

Install the Oracle Client software specified in the section Supported Platforms prior to running 
any of the installation utilities. 

The following prompt appears when executing the installation utility:

Enter Oracle Client Home Directory (<ENTER> quit):
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Note: If the environmental variable ORACLE_CLIENT_HOME is set, then 
the install script validates the variable. If it passes the validation, you will not be 
prompted for it. This is needed in order to run Perl installation utilities.
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Appendix C
Installation and Configuration Worksheets

This chapter provides the installation and configuration worksheets for Oracle Utilities Advanced 
Spatial and Operational Analytics. 

Following topics are discussed: 

• Configuration Worksheet for ETL Component Installation

• Configuration Worksheet for Dashboard Component Installation
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Configuration Worksheet for ETL Component Installation
Environment installation options are as shown in the section  below:

Environment Installation Options

Environment Configuration Options
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Environment Installation Options

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Oracle Client Home 
Directory

ORACLE_CLIENT_H 
OME

The home directory of 
the Oracle Client. The 
application will use the 
Perl included under this 
Oracle Client.

Example Location:
/oracle/client/product/
11.2.0.2

Installation Options OWB (OWB 
components)

OBIEE (OBIEE 
Components)

ALL (OWB and OBIEE 
Components)

Installation type to be 
selected. 

The following are the 
meaning of each 
installation type: 

OWB: This will install 
only the OWB 
components. 

OBIEE: This will install 
only the OBIEE 
components.  

ALL: This will install 
both OWB and OBIEE 
components. Select this 
option if both OWB and 
OBIEE will be deployed 
on the same server.  

Select the OWB Option
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Environment Mount 
Point

<SPLDIR> The mount point into 
which the application is 
installed. 
Local directory Where 
components to be 
installed.

For example:
/OUASA for UNIX and 
C:\OUASA for 
Windows

This mount point 
MUST exist and the 
administrator user ID 
MUST be able to write 
to this directory. (This is 
the user ID that is 
created specifically to 
administer the  
environments; the 
installation sets 
permissions on all 
subdirectories installed 
under this directory.

See <SPLENVIRON> 
below for more 
information on how this 
mount point is used.

Log File Mount Point <SPLDIROUT> A mount point that will 
contain any application 
output or application 
logs. 
Example value is /
OUASA/sploutput for 
UNIX installation or 
C:\OUASA\sploutput 
for Windows

Note: This value is 
currently not used and 
can be skipped.

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Environment Configuration Options
Following topics are discussed in this section: 

• Environment Description

• Database Configuration

• Design Repository Configuration

•  EMAIL Configuration

• Control Center Configuration

• External Data Source Configuration

Environment Name <SPLENVIRON> A descriptive name to be 
used as both a directory 
name under the mount 
point
<SPLDIR> and an 
environment descriptor. 
This value typically 
identifies the purpose of 
the environment. For 
example, DEV01 or 
CONV

Web Java Home 
Directory

JAVA_HOME The location on the disk 
where Java 1.6 is 
installed. 

For example:
$ORACLE_BI_HOME
/jdk

Database Home 
Directory

DATABASE_HOME Location on the disk 
where database client is 
installed for your 
particular installation.

Example location for 
Oracle Database:
/oracle/client/product/
11.2.0.2

Database Type The type of the database 
e.g. oracle, mssql or db2
Currently only "oracle" 
is supported.

oracle

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Environment Description
Environment description details are as shown in the table below: 

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Environment 
Description

DESC This is a free form text 
field to describe the 
purpose of the 
environment.

Database Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

OWB WorkSpace 
Owner

OWB_WS_OWNER OWB workspace Owner 
that is created in 
Creating and 
Configuring 
Workspace for an 
Initial Installation.

BIREPOWN

OWB WorkSpace 
Owner Password

OWB_WS_OWNER_P
ASS

OWB workspace Owner 
Password that is created 
in Creating and 
Configuring 
Workspace for an 
Initial Installation.

The password to login 
to Oracle warehouse 
Builder design center.

This is a Security Value.

BIREPOWN

Database Name OBIEE_DBNAME The name of the 
database instance that 
the application will be 
connecting to.

BI Database Name

Database Server OBIEE_DBSERVER Host name of the server 
where database resides.

BI Database Server

Database Port OBIEE_DBPORT Database port number 
on the database server 
used for connecting to 
the database

BI Database PORT
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Menu Option Name Used In 
Documentation Usage Customer Install 

Value

OWB WorkSpace User OWB_WS_USER OWB workspace User 
that is created in 
Creating and 
Configuring 
Workspace for an 
Initial Installation.

The User to login to 
Oracle warehouse 
Builder design Control 
center.

BIREPO

OWB Workspace user 
Password

OWB_WS_PASS OWB workspace User 
Password that is created 
in Creating and 
Configuring 
Workspace for an 
Initial Installation.

The password to login 
to Oracle warehouse 
Builder design Control 
center.

This is a Security Value.

BIREPO

OWB WorkSpace Name OWB_WS_NAME The name of the 
Workspace created using 
Repository Assistant

SPLBIREP

DWADM SCHEMA 
NAME

DWADM_SCHEMA The user ID to Register 
OWB locations

DWADM

DWADM SCHEMA 
Password

DWADM_PASS The password to 
Register OWB locations

DWADM

WORKFLOW 
MANAGER SCHEMA 
NAME

OWFMGR_SCHEMA The user ID to Register 
OWB locations

OWFMGR

DWADM SCHEMA 
Password

OWFMGR_PASS The password to 
Register OWB locations

OWFMGR

Design Repository Configuration
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Database Character Set Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Database Character set DBCS Database character Set 
to used to create the 
database

AL32UTF8

Editing Process Flow Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Repository Operating 
System

REPOPSYS Database operating 
system, for example, 
Win or Linux (any other 
platform)

Valid Values:
Win: windows
Linux: for any non 
windows platforms

Perl Compiler location PERLCMD Perl compiler set in 
database. For example:
/usr/bin/perl

<ORACLE_CLIENT>
/perl/bin/perl

Data and control files 
location

CTLFOLDER Data and control file 
extracts location, where 
flat files placed to 
pickup by the file 
processor.

For example: user 
location

Separator to be used FILESEP Separator to be used for 
OWB deployment, 
where database resides.

For example: Win '\\' 
and for Linux '/

For Unix      /
For Windows   \\

File Manager location FILEMGR File Manager location on 
the database server. 
Copy the 
splfilemanager.plx file 
from BI240/Scripts 
directory to this 
location.
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EMAIL Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Email ID of Sender EMAILIDSEN Email ID of sender to 
be configured in OWB 
while in deployment

For example: 
OWB@oracle.com

Email ID for Reply-To 
address

EMAILIDRPL Email ID of Reply TO 
to be configured in 
OWB while in 
deployment

Email ID of Receiver EMAILIDREC Email ID of Receiver to 
be configured in OWB 
while in deployment

SMTP server SMTPSRV Host name of the server 
where SMTP Service 
Configured

SMTP server port SMTPPORT Port number on the 
server where SMTP 
Service Configured

Control Center Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Repository Control 
Center Name

CCNAME OWB Repository 
Control center to 
created or used to 
deploy the OWB objects
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External Data Source Configuration

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Path of the External 
Datasource

EXTERNAMEDS Path of the extracts 
location

Path of the External 
Datasource LOG

EXTERNAMEDS_LO
G

Path of the extracts log 
location

File Processor Daemon 
Execution Switch

FPDEXECUTION_S
WITH

File processor execution 
switch

1

File Processor Extract 
Max Load

FPDEXTRACT_MAX
LOAD

File processor to pick up 
the Extractor to load

5

File Processor Scheduler 
Poll Duration

SCHEDULER_POLL_
DURATION

File Processor Scheduler 
Poll Duration

60

Configuration Worksheet for Dashboard Component Installation
Following topics are included here: 

• Environment Installation Options

• OBIEE Environment Configuration Options
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Environment Installation Options

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Oracle Client Home 
Directory

ORACLE_CLIENT_H 
OME

The home directory of 
the Oracle Client. The 
application will use the 
Perl included under this 
Oracle Client.

Example location:
/oracle/client/product/
11.2.0.2

Installation Options OWB (OWB 
components)
OBIEE (OBIEE 
Components)
ALL (OWB and OBIEE 
Components)

Installation type to be 
selected. 

The following are the 
meaning of each 
installation type: 

OWB: This will install 
only the OWB 
components. 

OBIEE: This will install 
only the OBIEE 
components.  

ALL: This will install 
both OWB and OBIEE 
components. Select this 
option if both OWB and 
OBIEE will be deployed 
on the same server.  

Select OBIEE Option
Installation and Configuration Worksheets C-11 
Oracle Utilities Advanced Spatial and Operational Analytics Installation Guide



Configuration Worksheet for Dashboard Component Installation
Environment Mount 
Point

<SPLDIR> The mount point into 
which the application is 
installed. For example:
/OUASA for UNIX and 
C:\OUASA for 
Windows

This mount point 
MUST exist and the 
administrator user ID 
MUST be able to write 
to this directory. (This is 
the user ID that is 
created specifically to 
administer the  
environments; the 
installation sets 
permissions on all 
subdirectories installed 
under this directory.

See <SPLENVIRON> 
below for more 
information on how this 
mount point is used.

Log File Mount Point <SPLDIROUT> A mount point that will 
contain any application 
output or application 
logs. 

Example value is /
OUASA/sploutput for 
UNIX installation or 
C:\OUASA\sploutput 
for Windows

Note: This value is 
currently not used and 
can be skipped.

Environment Name <SPLENVIRON> A descriptive name to be 
used as both a directory 
name under the mount 
point <SPLDIR> and 
an environment 
descriptor. This value 
typically identifies the 
purpose of the 
environment. For 
example, DEV01 or 
CONV

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for Dashboard Component Installation
Web Java Home 
Directory

JAVA_HOME The location on the disk 
where Java 1.6 is 
installed. 

For example:
$ORACLE_BI_HOME
/jdk

Database Home 
Directory

DATABASE_HOME Location on the disk 
where database client is 
installed for your 
particular installation.

Example location for 
Oracle Database:
/oracle/client/product/
11.2.0.2

Database Type The type of the database 
e.g. oracle, mssql or db2
Currently only "oracle" 
is supported.

oracle

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Configuration Worksheet for Dashboard Component Installation
OBIEE Environment Configuration Options

Menu Option Name Used In 
Documentation Usage Customer Install 

Value

Oracle BI Instance 
Home

ORACLE_INSTANCE Location on the disk 
where OBIEE software 
is installed instance 
home.

Example location for 
Oracle Database:
/orasw/BLDENGBI/
instances/instance1

Oracle BI Home ORACLE_BI_HOME Location on the disk 
where OBIEE software 
is installed Oracle_BI 
Home.

Example location for 
Oracle Database:
/orasw/BLDENGBI/ 
Oracle_BI1

Oracle BI Domain 
Home

DOMAIN_HOME Location on the disk 
where OBIEE software 
is installed Oracle_BI 
Home.

Example location for 
Oracle Domain home:
/orasw/BLDENGBI/ 
user_projects/domains/ 
bifoundation_domain

WebLogic Domain 
Console User Name

WLS_EM_USER WebLogic domain login 
user name.

You will be prompted 
for the password after 
installation.

WebLogic Domain 
Console Host

WLS_EM_HOST The host name on which 
the web application 
server resides.

Default value: <current 
server name>
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WebLogic Domain 
Console Port

WLS_EM_PORT A unique port number 
within the system that 
will be assigned to the 
HTTP port. This is the 
port number that is used 
as a part of the client 
URL request to connect 
to the host.
This will be OBIEE 
weblogic console admin 
port number.

Example value: 7001

Menu Option Name Used In 
Documentation Usage Customer Install 

Value
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Appendix D
Customizing Oracle Utilities Advanced Spatial 

and Operational Analytics

This chapter provides details about customizing Oracle Utilities Advanced Spatial and Operational 
Analytics. 

Following topics are discussed:

• Customizing Web Catalog

• Customizing Repository (RPD) File

• Customizing Oracle Warehouse Builder (OWB) Mappings

• Customizing the File Processor Mappings

Customizing Web Catalog
It is required that all customizations are done in a separate folder in order for those 
customizations to be preserved during the upgrade.

Note that dashboards would still be overwritten during the upgrade and any mappings between 
dashboards and custom (CM) answers will be lost and would need to be re-mapped manually.

Therefore, we recommend that the customer uses a staging (CM) environment for upgrade and 
manual re-mapping of dashboards before moving the upgraded CM content into the production 
environment.

Customizing Repository (RPD) File
It is required that all customizations are done in a separate repository (RPD) file, separated from 
the product's out-of-the-box RPD file. Any CM changes will be merged into the upgraded RPD 
file through the Merge utility of the OBIEE tool, together with the product's out-of-the-box RPD 
file. We recommend that the customer uses a staging (CM) environment for the RPD upgrade.

Customizing Oracle Warehouse Builder (OWB) Mappings
Oracle Warehouse Builder (OWB) mappings can be modified by updating the OUBI Metadata in 
the Table Mapping screen, and running the OWB Generator for the Fact or Dimension table that 
was modified, to generate TCL scripts that can then be loaded into OWB and deployed to the run-
time database.

After an upgrade, the OWB Generator would need to be rerun for any modified fact and 
dimension tables again, since the OWB Mappings will be overwritten by the default mappings in 
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Customizing Oracle Warehouse Builder (OWB) Mappings
an upgrade. We recommend that the customer user a staging (CM) environment to test the OWB 
upgrade and mapping redeployment prior to loading the OWB mappings in a production 
environment.

For other supported OWB modifications, refer to this support document in Oracle Support:

• Supported Oracle Warehouse Builder Changes for BI Oracle Utilities Business Intelligence 
[ID 877966.1]
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Customizing the File Processor Mappings
Customizing the File Processor Mappings
For adding new mappings so that they can be processed by the File Processor perform the 
following steps:

1. Create the "cm_schedulerParm.properties.exit_1.include" file under templates folder.

For UNIX:

$SPLEBASE/templates

For Windows:

%SPLEBASE%\templates

2. Add the following entry in "cm_schedulerParm.properties.exit_1.include" in the file:

extract.file.mapping.override.count = <COUNT_NUMBER>

Where COUNT_NUMBER is scheduler parameter mapping count from source 
parameter file (viz. extract.file.mapping.count) + user configurable mappings count.

For example:

extract.file.mapping.override.count = 251

3. Add the new user parameter mappings in "cm_schedulerParm.properties.exit_1.include" file.

Example:

extract.file.mapping250 = <MAPPING1>

extract.file.mapping251 = <MAPPING2>

Note: Refer to Oracle Utilities Advanced Spatial and Operational Analytics Administrator's Guide 
for mapping format.

4. Run the initialSetup command:

For UNIX:

$SPLEBASE/initialSetup.sh

For Windows:

%SPLEBASE%\initialSetup.sh

5. Start the File Processor.

For UNIX:

cd $SPLEBASE/bin

nohup ksh ./startFileprocessordaemon.sh > ../tmp/

consoleFileprocessordaemon.log 2>&1 &

For Windows:

startFileprocessordaemon.cmd
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Appendix E
Additional Resources

Contacting Oracle Support
To contact Oracle support, visit the Oracle Support Web site at

http://www.oracle.com/support/index.html
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Appendix F
License and Copyright Notices

Third Party Products
Following topic is discussed in detail: 

Notice Concerning Usage of Mapping Data

Notice Concerning Usage of Mapping Data
This section includes the following: 

• Digital Map Data Provider

• eLocation's Regional Coverage

Digital Map Data Provider
Oracle Utilities Advanced Spatial and Operational Analytics require digital map data for providing 
the mapping functionality. This data could be obtained by licensing eLocation (http://
elocation.oracle.com), Oracle's Location Services. eLocation is a comprehensive location mapping 
tool that comprises a number of components including geo-coding, mapping and a routing engine. 
It uses Navigation Technologies Corporation's (NAVTEQ) data. 

eLocation's Regional Coverage
eLocation is currently licensed for background maps in Western Europe and North America. 
Refer http://elocation.oracle.com/elocation/legal.html for more information on eLocation’s 
regional coverage and Terms and Conditions. 

Customers outside the eLocation covered region or who don't license eLocation can license map 
data from Navteq or any other third party map data providers such as: 

• Google Maps

• Bing Maps

Oracle Utilities Advanced Spatial and Operational Analytics provide an easy plug-in feature to 
enable Google or Bing maps. 

For details on map data configuration, refer to Setting up a Third-Party Base Map on page 1-
32.
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